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Официальное уведомление

Гарантийные обязательства

Единственные гарантийные обязательства в отношении продуктов и услуг компании НР изложены в
заявлении о прямых гарантийных обязательствах, прилагаемом к таким продуктам и услугам. Никакая часть
данного документа не может быть истолкована в качестве дополнительных гарантийных обязательств.
Компания НР не несет ответственность за технические или редакторские ошибки и пропуски, содержащиеся
в данном документе.
Содержащаяся в данном документе информация может быть изменена без уведомления.

Пояснения к ограниченным правам

Конфиденциальное компьютерное программное обеспечение. Для владения, использования или копирования
необходима действительная лицензия компании НР. В соответствии с положениями FAR 12.211 и 12.212
коммерческое компьютерное программное обеспечение, документация по компьютерному программному
обеспечению и технические данные на коммерческие продукты лицензируются государственным
учреждениям США на условиях стандартной коммерческой лицензии поставщика.

Веб-узлы сторонних производителей 

Компания НР предоставляет ссылки на веб-узлы сторонних производителей, на которых можно найти
дополнительную информацию. Содержимое и доступность таких веб-узлов могут быть изменены без
уведомления. Компания НР не делает каких бы то ни было заявлений и не дает каких бы то ни было гарантий
в отношении содержимого или доступности таких веб-узлов.

Уведомление об авторских правах

© 1993 - 2007 Mercury Interactive Corporation. Все права защищены.

Уведомление о товарных знаках

Adobe® является товарным знаком компании Adobe Systems Incorporated.
Microsoft® и Windows® являются зарегистрированными в США товарными знаками корпорации Майкрософт.
Oracle® является зарегистрированным в США товарным знаком корпорации Oracle, Редвуд, Калифорния.
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Обновления документации

На титульном листе настоящего документа приведена следующая идентифицирующая информация:

• номер версии программного обеспечения;

• дата опубликования документа, которая изменяется при каждом обновлении документации;

• дата релиза ПО, обозначающая дату релиза текущей версии программного обеспечения.

Чтобы проверить последние обновления или убедиться в том, что вы пользуетесь самой последней
редакцией, перейдите на

http://ovweb.external.hp.com/lpe/doc_serv/ 
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Поддержка

Поддержка продуктов Mercury

Сведения о поддержке продуктов, ранее выпускавшихся компанией Mercury, можно получить одним из
следующих способов.

• Если вы работаете с партнером HP в рамках программы Software Services Integrator (SVI) (www.hp.com/
managementsoftware/svi_partner_list), то свяжитесь со своим агентом SVI.

• Если у вас есть действующий контракт на оказание поддержки программного обеспечения компании НР, 
зайдите на веб-узел поддержки программного обеспечения компании НР и найдите ответы на интересующие 
вас вопросы с помощью функции поиска Self-Solve Knowledge Search.

• Самые последние данные о процессах и средствах поддержки, доступных для продуктов, ранее 
выпускавшихся компанией Mercury, приведены на веб-узле поддержки клиентов Mercury по адресу: http://
support.mercury.com.

• Если у вас есть дополнительные вопросы, свяжитесь с торговым представителем компании НР.

Поддержка программного обеспечения НР

Посетите веб-узел поддержки программного обеспечения НР по адресу:

www.hp.com/managementsoftware/services 

Служба поддержки в режиме онлайн программного обеспечения НР предоставляет эффективный доступ к
интерактивным инструментам технической поддержки. Наши клиенты, имеющие право на техническую
поддержку, могут использовать данный веб-узел для:

• поиска интересующих их документов в базе знаний;

• подачи и отслеживания заявок на техническое обслуживание и расширение функциональных возможностей;

• загрузки пакетов исправлений программного обеспечения;

• управления контрактами на оказание поддержки;

• поиска контактов в компании НР в связи с технической поддержкой;

• просмотра сведений о доступных услугах;

• участия в обсуждениях с другими покупателями программного обеспечения;

• поиска курсов обучения по программному обеспечению и регистрации для участия них.

Для получения доступа к большинству разделов поддержки сначала необходимо зарегистрироваться в
качестве пользователя службы НР Passport, а затем войти в систему. Для ряда разделов поддержки также
необходим контракт на оказание поддержки. Получить более подробные сведения об уровнях доступа можно
по адресу: www.hp.com/managementsoftware/access_level 
Чтобы зарегистрироваться на получение идентификатора пользователя службы НР Passport, перейдите на
страницу: 
       www.managementsoftware.hp.com/passport-registration.html
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Вас приветствует учебное руководство

Это учебное руководство представляет собой материалы для 
самостоятельного изучения HP Quality Center — средства управления 
тестированием на основе веб-технологий, разработанного компанией HP. 

В руководстве описаны процедуры использования Quality Center для 
управления процессом тестирования приложений. Оно знакомит 
пользователей с процессами определения релизов и требований, 
планирования тестов, выполнения тестов, отслеживания дефектов, 
оповещения об изменениях и анализа результатов. В нем также приведены 
способы настройки проектов.

Перед началом работы
Для работы с этим учебным руководством клиентский компьютер 
Quality Center должен иметь доступ к следующим компонентам:

➤ QualityCenter_Demo — демонстрационный проект, который помогает 
ознакомиться с Quality Center и содержит примеры релизов, требований, 
тестов, наборов тестов, выполнений тестов и дефектов.

Примечание. Настоятельно рекомендуется работать с новой копией 
проекта QualityCenter_Demo. Для получения дополнительных сведений 
обратитесь к администратору сайта Quality Center.

➤ Mercury Tours — пример программы, имитирующей сайт, предоставляющий 
услуги по бронированию авиарейсов, гостиничных номеров, морских 
путешествий, аренде автомобилей и планированию отпусков.
7



Руководство пользователя
Примечание. Демонстрационный проект QualityCenter_Demo и 
приложение Mercury Tours необходимо устанавливать только при 
установке Quality Center на сервере. Дополнительные сведения см. в 
Руководство по установке HP Quality Center.

➤ Чтобы выполнить автоматизированные тесты, приведенные в настоящем 
учебном руководстве, необходимо установить на компьютере приложение 
QuickTest Professional или WinRunner. 

Примечание. 

➤ Для интеграции Quality Center с QuickTest Professional необходимо 
установить надстройки HP QuickTest Professional Add-in и 
HP Quality Center Connectivity Add-in, которые можно загрузить со 
страницы надстроек HP Quality Center. 

➤ Для интеграции Quality Center с WinRunner следует установить 
надстройку HP Quality Center Connectivity Add-in, которую можно 
загрузить со страницы надстроек HP Quality Center 
. 

Дополнительные сведения см. в Руководство по установке 
HP Quality Center.
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Руководство пользователя
Организация учебного руководства
Учебное руководство состоит из следующих уроков: 

 Урок 1 Знакомство с Quality Center
Знакомит с процессом тестирования Quality Center, а также 
пользовательским интерфейсом Quality Center и примером сайта Mercury 
Tours. 

 Урок 2 Определение релизов и циклов
Содержит описание процедуры определения релизов и циклов, методов 
отслеживания процесса их создания и контроля качества.

 Урок 3 Определение требований
Содержит описание процедуры определения требований, просмотра и 
изменения дерева требований, а также преобразования требований в 
тесты.

 Урок 4 Разработка плана тестирования
Содержит описание процедур создания дерева планов тестирования, 
разработки и копирования шагов тестов, вызова теста с параметрами, 
связывания тестов с требованиями, а также автоматизации ручных тестов.

 Урок 5 Выполнение тестов
Содержит описание процедур определения наборов тестов, составления 
расписания запуска тестов и выполнения ручных и автоматизированных 
тестов.

 Урок 6 Добавление и отслеживание дефектов
Содержит описание процедур добавления новых дефектов, поиска 
аналогичных дефектов, обновления дефектов, связывания дефектов с 
тестами, а также создания избранных представлений.
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Руководство пользователя
 Урок 7 Оповещение об изменениях
Содержит описание процедуры отслеживания изменений, внесенных в 
требования, тесты и дефекты в процессе выполнения тестирования 
проекта.

 Урок 8 Анализ процесса тестирования
Содержит описание процедуры контроля процесса тестирования с 
помощью создания отчетов и диаграмм.

 Урок 9 Настройка проектов
Содержит описание процедуры настройки пользователей проекта, а также 
процедуры создания полей и списков проекта.

 Урок 10 Дальнейшие действия
Содержит описание процедуры начала тестирования приложения и 
источниках дополнительной информации о программе Quality Center. 
10



Руководство пользователя
Соглашения о типографских обозначениях
В данном руководстве используются следующие типографские 
обозначения:

Элементы 
пользовательского 
интерфейса 

Этот стиль применяется для названий элементов 
интерфейса, используемых для выполнения 
пользователями определенных действий, имен 
файлов и путей к ним, а также для других элементов, 
которые необходимо выделить. Например, "Нажмите 
кнопку Save".

Аргументы Этот стиль применяется к аргументам методов, 
свойств или функций, а также к названиям руководств. 
Например, "Смотрите руководство пользователя HP 
User’s Guide".

<Замените 
значение>

Угловыми скобками выделяют часть пути к файлу или 
URL-адрес, которую необходимо заменить реальным 
значением. Например, <Папка установки 
MyProduct>\bin.

Пример Этот стиль используется для примеров и выделения 
текста, который следует ввести дословно. Например, 
"Введите в поле текст Hello".

CTRL+C Этот стиль применяется для клавиш на клавиатуре. 
Например, "Нажмите клавишу ENTER".

имя_функции Этот стиль применяется для названий методов или 
функций. Например, "Оператор wait_window имеет 
следующие параметры:".

[ ] В квадратные скобки заключаются необязательные 
аргументы.

{ } Фигурные скобки указывают на то, что одно из 
заключенных в них значений должно быть назначено 
текущему аргументу. 
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Руководство пользователя
... В строке синтаксической структуры многоточие 
указывает на то, что в строку можно включить 
большее количество элементов того же самого 
формата. Например в программировании многоточие 
используется, чтобы указать строки программного 
кода, которые были специально пропущены.

| Вертикальная черта указывает на то, что необходимо 
выбрать один из вариантов, разделенных чертой.
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1
Знакомство с  Quality Center

Тестирование приложений – это сложный процесс. С помощью 
Quality Center можно упростить упорядочивание и управление этапами 
процесса тестирования приложения, включая определение релизов и 
требований, разработку плана тестирования, выполнение тестов и 
отслеживание дефектов.

Этот урок содержит следующие разделы: Стр.

Процесс тестирования Quality Center 14

Запуск Quality Center 15

Окно Quality Center 18

Пример веб-сайта Mercury Tours 21
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Урок 1 • Знакомство с Quality Center
Процесс тестирования Quality Center
Quality Center предлагает упорядоченную структуру для тестирования 
приложений перед их развертыванием. Поскольку планы тестирования 
изменяются из-за появления новых или измененных требований к 
приложению , то необходим центральный репозиторий данных для 
организации процесса тестирования и управления им. Quality Center 
проведет вас по всем этапам процесса тестирования.

Процесс тестирования Quality Center состоит из пяти этапов:  

➤ Определение релизов. Разработка плана управления релизами и 
циклами. 

➤ Определение требований. Описание  требований к функциональности и 
производительности, которые необходимо протестировать.

➤ Разработка плана тестирования. Планирование и утверждение тестов, 
которые необходимо провести, а также выбор способа их выполнения. 

➤ Выполнение тестов. Организация наборов тестов, составление 
расписания их запуска, выполнение тестов и анализ данных, полученных в 
ходе их  выполнения.

➤ Отслеживание дефектов. Добавление дефектов, обнаруженных в 
приложении, и отслеживание того, насколько исправления улучшают 
ситуацию.

Во время процесса тестирования можно создавать отчеты и диаграммы, 
которые помогут принять решение, следует ли  запускать приложение в 
зависимости от степени его готовности. 
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Урок 1 • Знакомство с Quality Center
Запуск Quality Center
Запуск Quality Center осуществляется в веб-обозревателе, в строку адреса 
которого вводится URL-адрес HP Quality Center.

Для запуска Quality Center:

 1 Откройте окно Options среды Quality Center.

Откройте веб-обозреватель и введите URL-адрес Quality Center:
http://<имя сервера Quality Center>[:<номер порта>]/qcbin. Если путь к 
Quality Center неизвестен, обратитесь к системному администратору.

Откроется окно параметров Quality Center.

 2 Откройте Quality Center.

Щелкните ссылку Quality Center.

Во время первого запуска Quality Center файлы загрузятся на 
используемый компьютер. После этого Quality Center выполнит проверку 
версии. Если на сервере будет обнаружена обновленная версия, файлы 
обновления будут загружены на используемый компьютер. 
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Урок 1 • Знакомство с Quality Center
Примечание. Quality Center предложит установить платформу Microsoft 
.NET Framework 2.0, если она еще не установлена на компьютере. Для 
установки этой платформы следуйте инструкциям мастера установки 
обновления программного обеспечения (если не установлена программа  
Windows Installer 3.1) и программы установки Microsoft .NET Framework 2.0.

Откроется окно входа вQuality Center.

 3 Введите имя пользователя и пройдите процедуру авторизации. 

В поле Login Name введите одно из следующих имен: alice_qc, cecil_qc 
или michael_qc.

Пропустите поле Password. Указанным выше пользователям не присвоен 
пароль.
16



Урок 1 • Знакомство с Quality Center
Совет. Если ранее вы входили в проект, то можно установить флажок 
Automatically log in to my last domain and project on this machine , если 
необходимо  автоматически входить в последний проект Quality Center, с 
которым вы работали. 

Нажмите кнопку Authenticate. Quality Center проверит ваше имя 
пользователя и пароль и определит, к каким доменам и проектам у вас есть 
доступ.

 4 Войдите в проект.

В списке Domain выберите DEFAULT.

В списке Project выберите QualityCenter_Demo.

Примечание. Если в списке содержится несколько проектов 
QualityCenter_Demo, обратитесь к администратору сайта Quality Center, 
чтобы выяснить, какой проект следует использовать.

Нажмите кнопку Login.

После входа в проект откроется главное окно Quality Center и отобразится 
модуль, в котором вы работали в прошлый раз. В правом верхнем углу 
окна отображается имя домена, имя проекта и имя пользователя.

При  первом запуске Quality Center откроется страница приветствия. Со 
страницы приветствия можно перейти непосредственно к этому учебному 
руководству или к  другой документации по Quality Center. Если не 
требуется, чтобы страница приветствия отображалась при каждом входе в 
Quality Center, установите флажок Don’t show this again. Чтобы открыть 
страницу приветствия, выберите Help > Welcome Page.
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Окно Quality Center
В этом упражнении вы сможете изучить модули Quality Center и их общие 
элементы.

Процедура изучения окна Quality Center.

 1 Изучите модули Quality Center.

➤ Нажмите кнопку Releases на боковой панели. Модуль Releases позволяет 
определить релизы и циклы для управления процессом тестирования.

➤ Нажмите кнопку Requirements  на боковой панели. В модуле Requirements 
можно определить требования к тестированию. Они включают в себя 
объекты тестирования, определение разделов и элементов требований, а 
также анализ требований.

➤ Нажмите кнопку Test Plan на боковой панели. В модуле Test Plan можно 
разработать план тестирования на основании требований к тестированию. 
В него входит разделение плана тестирования  на категории, разработка 
тестов, автоматизация тестов в тех случаях, когда это целесообразно, и 
анализ плана.

➤ Нажмите кнопку Test Lab  на боковой панели. Модуль Test Lab позволяет 
тестировать приложение с помощью выбранных тестов и анализировать 
результаты.

➤ Нажмите кнопку Defects  на боковой панели. Модуль Defects позволяет 
добавлять дефекты, определять приоритеты исправлений, исправлять 
открытые дефекты и анализировать данные.

Примечание. В зависимости от имеющейся лицензии Quality Center вы 
также можете получить доступ к модулю Business Components. Модуль 
Business Components позволяет специалистам в данной области управлять 
процессом оптимизации качества. Дополнительные сведения см. в 
документе Руководство пользователя по HP Business Process Testing.
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 2 Изучите общие элементы Quality Center.

Все модули Quality Center имеют общие элементы. Например, нажмите 
кнопку Requirements на боковой панели.
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Каждый модуль Quality Center содержит следующие основные элементы:

➤ Quality Center общую панель инструментов. Она расположена в 
правом верхнем углу окна. Доступ к ней осуществляется из всех 
модулей, и на ней расположены следующие кнопки:

➤ Строка меню модуля. Отображает названия пунктов меню, из которых 
выбираются команды в текущем модуле Quality Center.

➤ Панель инструментов модуля. Расположена под строкой меню. 
Содержит кнопки часто использующихся команд в текущем модуле 
Quality Center.

Кнопка Описание

Перемещение назад к предыдущему местоположению в 
Quality Center.

Перемещение вперед к следующему местоположению в 
Quality Center.

Содержит параметры, позволяющие выбирать другие проекты, 
настраивать свой проект, добавлять новые дефекты, проверять 
орфографию и грамматику, удалять данные журнала из проекта, 
открывать генератор документов, создавать отчеты Excel и 
открывать модуль Dashboard.

Подробные сведения о кнопке Tools приведены в Руководство 
пользователя HP Quality Center.

Позволяет открывать  комплект документации по Quality Center и 
другие дополнительные онлайновые ресурсы. Кроме того, 
позволяет отображать информацию о версии каждого клиентского 
компонента Quality Center. Дополнительные сведения см. в 
разделах «Библиотека документации» на стр. 168 и 
«Дополнительные сетевые ресурсы» на стр. 170.

Позволяет выходить из текущего проекта и переходить в  окно 
входа вHP Quality Center. 
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Пример веб-сайта Mercury Tours
 Mercury Tours представляет собой пример веб-приложения, 
использующийся в данном учебном руководстве. Он имитирует веб-сайт по 
бронированию авиарейсов, гостиничных номеров, аренды автомобилей, 
морских путешествий и отпусков. Теперь вам следует ознакомиться с этим 
приложением.

Для изучения Mercury Tours:

 1 Откройте приложение Mercury Tours.

Откройте еще одно окно веб-обозревателя и введите следующий URL-
адрес: http://<имя сервера Quality Center>[:<номер порта>]/mtours

Откроется главная страница Mercury Tours.
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 2 Зарегистрируйтесь в Mercury Tours.

Нажмите Register. Откроется страница регистрации. 

В поле User Information введите любое имя пользователя и пароль и 
подтвердите пароль. (Вводить другую информацию необязательно).

Нажмите кнопку Submit. Mercury Tours подтвердит вашу регистрацию.
22



Урок 1 • Знакомство с Quality Center
 3 Войдите в Mercury Tours. 

Нажмите кнопку Sign-on. Откроется страница Sign-on. 

Введите имя пользователя и пароль, которые вы использовали при 
регистрации. Нажмите кнопку Submit.
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Откроется страница Flight Finder.

 4 Забронируйте авиабилет. 

Следуйте инструкциям на экране, чтобы забронировать авиабилет. 

 5 Завершите сеанс работы в Mercury Tours. 

Для выхода нажмите кнопку Sign-off.

Теперь, когда вы ознакомились с процессом тестирования в программе 
Quality Center, модулями Quality Center и примером веб-приложения 
Mercury Tours, можно переходить к уроку Урок 2, «Определение релизов и 
циклов». В уроке 2 вы узнаете, как определить релизы и циклы.
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2
Определение релизов и циклов

Процесс тестирования приложения начинается с определения релизов в 
модуле Releases. Релиз представляет собой группу изменений, внесенных 
в одно или несколько приложений, которые доступны для одновременного 
распространения.  Каждый релиз может содержать несколько циклов. Цикл 
представляет собой этап разработки и контроля качества релиза на основе 
временных рамок проекта. Как релизы, так и циклы имеют определенные 
даты начала и завершения.

После создания требований в модуле Requirements их необходимо 
назначить релизам и циклам (см. урок «Определение требований» на 
стр. 33). Затем следует разработать план тестирования этих требований, а 
затем выполнить тесты из набора, содержащиеся в папке наборов тестов. 
Каждая папка наборов тестов назначается циклу (см. урок «Выполнение 
тестов» на стр. 75). Когда начнется регистрация дефектов, их следует 
назначить конкретным циклам (см. урок «Добавление и отслеживание 
дефектов» на стр. 109). Таким образом, можно отслеживать процесс 
создания релизов и контролировать их качество.

Этот урок содержит следующие разделы: Стр.

Определение релизов и циклов 26

Просмотр релизов и циклов 28
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Определение релизов и циклов
В этом упражнении вы определите релиз и циклы, его составляющие. 
Релизы и циклы имеют даты начала и завершения их создания. Диапазон 
дат начала и завершения создания цикла должен находиться в пределах 
диапазона дат создания и завершения соответствующего релиза.

Для определения релиза и его циклов:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в проект. 
Дополнительные сведения см. в разделе «Запуск Quality Center» на стр. 15.

 2 Отобразите модуль Releases.

Нажмите кнопку Releases на боковой панели.

 3 Создайте папку нового релиза.

В дереве релизов выберите корневую папку Releases. Нажмите кнопку 
New Release Folder. Откроется диалоговое окно New Release Folder.

В поле Release Folder Name введите Service Packs.

Нажмите кнопку OK. Папка релиза Service Packs добавится в дерево 
релизов.

В поле Description на правой панели введите следующее описание папки 
релизов: This folder contains service pack releases.

 4 Добавьте релиз.

Убедитесь, что в дереве релизов выбрана новая папка релизов Service 
Packs.
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Нажмите кнопку New Release. Откроется диалоговое окно New Release.

В поле Release Name введите Service Pack 1.

Нажмите кнопку OK. Папка релиза Service Pack 1 добавится в папку 
релизов Service Packs.

На правой панели в поле Start Date нажмите кнопку вниз и выберите 
вчерашнюю дату. В поле End Date нажмите кнопку вниз и выберите дату, 
которая наступит через 2 месяца после сегодняшнего дня. В поле 
Description введите следующее описание релиза: This release is the first 
service pack release.

 5 Добавьте цикл к релизу.

В дереве релизов выделите релиз Service Pack 1.

Нажмите кнопку New Cycle. Откроется диалоговое окно New Cycle.

В поле Cycle Name введите Cycle 1 - New Features.

Нажмите кнопку OK. Цикл Cycle 1 - New Features добавится к релизу 
Service Pack 1.

На правой панели в поле Start Date нажмите на стрелку вниз и выберите 
вчерашнюю дату. В поле End Date нажмите на стрелку вниз и выберите 
дату, которая будет через 1 месяц от сегодняшнего дня. В поле Description 
введите следующее описание цикла: This cycle tests new features added for 
this service pack.
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 6 Добавьте к релизу второй цикл.

В дереве релизов выделите релиз Service Pack 1.

Выберите Releases > New Cycle. Откроется диалоговое окно New Cycle.

В поле Cycle Name введите Cycle 2 - Full.

Нажмите кнопку OK. Цикл Cycle 2 - Full добавится к релизу Service Pack 1.

На правой панели в поле Start Date нажмите кнопку  вниз и выберите дату, 
которая наступит через 1 месяц и 1 день после сегодняшнего дня.  В поле 
End Date нажмите кнопку вниз и выберите дату, которая наступит через 2 
месяца после сегодняшнего дня. В поле Description введите следующее 
описание цикла: This cycle fully tests all application features.

Просмотр релизов и циклов
Можно просматривать диаграммы и статистические данные, отражающие 
процесс создания и качество релизов и циклов. Данное упражнение 
позволяет ознакомиться с этими диаграммами и статистическими 
данными. В последующих уроках вы увидите, как диаграммы и 
статистические данные изменяются в процессе изменения состояния 
проекта.

Для просмотра релизов и циклов:

 1 Убедитесь, что отображается модуль Releases.

Если модуль Releases не отображается, нажмите кнопку Releases на 
боковой панели.
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 2 Отобразите диаграмму Progress для версии Service Pack 1.

В дереве релизов выберите релиз Service Pack 1, расположенный в папке 
релизов Service Packs. На правой панели перейдите на вкладку Progress.

На вкладке Progress отображается процесс создания релиза с помощью 
покрытия требований, времени, прошедшего с даты начала создания 
релиза и времени, оставшегося до даты его завершения, а также 
количества проведенных тестов и тестов, которые еще необходимо 
выполнить. Поскольку требования или тесты еще не созданы, на 
диаграмме Coverage Progress требований указано значение 0%.
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 3 Отобразите диаграмму Quality для релиза Service Pack 1.

На правой панели выберите вкладку Quality.

На диаграмме Defect Opening Rate отображается сводная информация о 
количестве дефектов, обнаруженных в выбранном релизе. Дефекты 
группируются в соответствии с их уровнем серьезности. Текущий статус 
дефектов не рассматривается. Поскольку отчет о дефектах еще не создан, 
диаграмма пуста.

На диаграмме Outstanding Defects отображается сводная информация о 
количестве необработанных дефектов в выбранном релизе. Дефекты 
группируются в соответствии с их уровнем серьезности. По умолчанию на 
диаграмме отображаются дефекты со статусами New, Open и Reopen. 

Несмотря на то, что отчет о дефектах еще не создан, на диаграмме 
показаны необработанные дефекты. Это объясняется тем, что некоторые 
дефекты в данном проекте не назначены конкретному релизу и, 
следовательно, считаются необработанными. 
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 4 Отобразите диаграммы Progress и Quality для цикла.

В дереве релизов выберите Cycle 1 - New Features, которая находится в 
папке Service Pack 1. 

На правой панели выберите вкладку Progress. На этой вкладке видно, что 
информация о цикле сходна с информацией о релизе, но на уровне цикла. 
Поскольку еще не созданы требования и тесты для данного релиза, на 
диаграмме Coverage Defects требований указано значение 0%.

Теперь выберите вкладку Quality. Обе диаграммы пусты.

Теперь, когда вы познакомились с процессом определения и просмотра 
релизов и циклов, можно переходить к занятию Урок 3, «Определение 
требований». В уроке 3 вы узнаете, как определить требования к 
тестированию. 
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3
Определение требований

После определения релизов и циклов необходимо задать требования в 
модуле Requirements. Требования подробно описывают, что необходимо 
протестировать в приложении, и предоставляют группе тестировщиков 
основные сведения для всего процесса тестирования.

Задать требования в Quality Center можно путем создания дерева 
требований. Оно является графическим представлением описания 
требований, отображающим требования в виде иерархической структуры. 
Можно группировать и сортировать требования в дереве, контролировать 
распределение задач, отслеживать соответствие требованиям и создавать 
подробные отчеты и диаграммы.

После разработки тестов в модуле Test Plan можно связать требования с 
тестами (см. урок «Разработка плана тестирования» на стр. 49). Позже, 
когда вы начнете регистрировать дефекты, также можно будет связать 
требования с дефектами (см. урок «Добавление и отслеживание 
дефектов» на стр. 109). Таким образом можно отслеживать требования к 
тестированию приложений на всех этапах процесса тестирования. При 
изменении какого-либо требования можно сразу определить, на какие 
тесты и дефекты будет оказано воздействие, и кто за это несет 
ответственность.

Этот урок содержит следующие разделы: Стр.

Задание требований 34

Просмотр требований 38

Изменение требований 41

Преобразование требований 43
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Задание требований
В ходе этого упражнения вы зададите требования к тестированию 
функциональных возможностей приложения для бронирования круизов на 
сайте Mercury Tours.

Примечание. Кроме создания требований непосредственно в 
Quality Center можно импортировать требования в проект Quality Center из 
Microsoft Word или Microsoft Excel. Для импорта из Word установите 
надстройки HP Quality Center Microsoft Word Add-in и HP Quality Center 
Connectivity Add-in . Для импорта из Excel установите надстройки  
HP Quality Center Microsoft Excel Add-in и HP Quality Center Connectivity 
Add-in. Загрузить эти надстройки  можно со страницы надстроек 
HP Quality Center. Дополнительные сведения см. в документе Руководство 
по установке HP Quality Center.

Для задания требования:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в проект. 
Дополнительные сведения см. в разделе «Запуск Quality Center» на стр. 15.

 2 Отобразите модуль Requirements.

Нажмите кнопку Requirements на боковой панели.

Выберите View > Requirements Tree, чтобы отобразить требования в виде 
дерева.

Примечание. В ходе данного урока используется представление 
Requirements Tree. Дополнительные сведения о представлении 
Requirements Grid см. в разделе «Просмотр требований» на стр. 38. 
Дополнительные сведения о представлениях Requirement Details и 
Coverage Analysis см. в разделе «Сведения о создании и просмотре 
требований» на стр. 62.
34



Урок 3 • Определение требований
 3 Создайте новое требование и назначьте ему типу требований.

Разверните корневой каталог Requirements и выберите требование 
Mercury Tours Application. 

Нажмите кнопку New Requirement. Откроется диалоговое окно Create New 
Requirement.

В поле Requirement Type выберите Functional. Каждое требование 
относится к определенному типу требований. Тип требований, к которому 
относится требование, определяет, какие поля доступны для этого 
требования. Ваш администратор проекта может изменять существующие 
типы и добавлять новые. Дополнительные сведения о конфигурации типов 
требований см. в документе Руководство администратора 
HP Quality Center.

В поле Requirement Name введите Cruise Reservation.
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Нажмите кнопку OK. Откроется диалоговое окно New Requirement.

 4 Добавьте к требованию подробные сведения.

Введите или выберите следующее:

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Reservation добавится к 
требованиям в дереве Mercury Tours Application.

Нажмите кнопку Close, чтобы закрыть диалоговое окно New Requirement.
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 5 Добавьте дочернее требование.

Убедитесь, что в дереве требований выбрано новое требование Cruise 
Reservation.

Нажмите кнопку New Requirement, чтобы добавить требование ниже 
Cruise Reservation. В диалоговом окне Create New Requirement выберите 
Functional в поле Requirement Type и введите Cruise Search в поле 
Requirement Name. Нажмите кнопку OK.

В диалоговом окне New Requirement введите или выберите следующее:

Priority: 4-Very High

Product: Mercury Tours Web Site

Нажмите кнопку Submit. Требование Cruise Search добавится в качестве 
дочернего требования к требованию Cruise Reservation.

Нажмите кнопку Close, чтобы закрыть диалоговое окно New Requirement.

 6 Добавьте дополнительное дочернее требование.

В дереве требований выделите Cruise Reservation.

Повторите шаг 5. На этот раз в поле Requirement Name введите Cruise 
Booking. 

Требование Cruise Booking добавится в качестве дочернего к требованию 
Cruise Reservation.
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 7 Присвойте требование циклу.

В дереве требований выделите Cruise Reservation.

Выберите Requirements > Assign to cycle. Откроется дерево релизов. В 
папке релизов Service Packs, релизе Service Pack 1 установите флажок 
для цикла Cycle 1 - New Features. Чтобы закрыть дерево релизов, нажмите 
кнопку OK. Нажмите Yes, чтобы назначить цикл дочерним требованиям 
главного требования, а также самому требованию.

В отображенных столбцах можно увидеть, что Quality Center присваивает 
значение Cycle 1 - New Features полю Target Cycle  и значение Service 
Pack 1 полю Target Release. 

Просмотр требований
Способ отображения требований можно изменить. В ходе этого 
упражнения вы научитесь увеличивать и уменьшать размер дерева 
требований, а также узнаете о способах отображения и фильтрации 
требований в таблице требований.

Порядок просмотра требований.

 1 Убедитесь, что отображается модуль Requirements.

Если модуль Requirements не отображен, нажмите кнопку Requirements на 
боковой панели. 

Выберите View > Requirements Tree для отображения требований в окне 
Requirements Tree.

 2 Увеличьте и уменьшите размер дерева требований.

В дереве требований выберите Cruise Reservation. 
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Для увеличения нажмите кнопку Zoom In на панели инструментов. Дерево 
требований отображает только дочерние требования Cruise Reservation.

Чтобы произвести действие, обратное увеличению, и отобразить все 
дерево требований, нажмите стрелку Zoom In и выберите Zoom Out To 
Root.

 3 Просмотр требований в таблице требований.

Выберите View > Requirements Grid для отображения требований в 
сплошном неиерархическом виде. В каждой строке таблицы отображается 
отдельное требование.

 4 Фильтрация таблицы требований.

Нажмите кнопку Set Filter/Sort. Откроется диалоговое окно Filter. 
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Нажмите поле Filter Condition, которое соответствует полю Creation Date. 
Нажмите кнопку обзора. Откроется диалоговое окно Select Filter Condition, 
отображающее сегодняшнее число в поле Condition.

Выберите дату добавления требований или используйте дату по 
умолчанию.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы применить выбранный фильтр.

В таблице Requirements Grid отображаются добавленные требования.
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Изменение требований
В дереве требований можно изменять требования. В ходе этого 
упражнения вы научитесь копировать, переименовывать, перемещать и 
удалять требования.

Порядок изменения требований.

 1 Убедитесь, что отображается модуль Requirements.

Если модуль Requirements не отображен, нажмите кнопку Requirements на 
боковой панели.

Выберите View > Requirements Tree для отображения требований в виде 
Requirements Tree.

 2 Скопируйте требование

В дереве требований щелкните правой кнопкой мыши Cruise Reservation и 
выберите Copy. 

Правой кнопкой мыши щелкните требование Mercury Tours Application и 
выберите Paste. 

Откроется окно с предупреждением, поскольку происходит дублирование 
имени требования. Нажмите кнопку OK. Требование будет вставлено под 
выбранным требованием. К окончанию имени требования добавится 
_Copy_1. Обратите внимание, что требование было скопировано и 
вставлено с помощью дочернего требования.

 3 Переименуйте требование Cruise Reservation_Copy_1.

Щелкните правой кнопкой мыши требование Cruise Reservation_Copy_1 и 
выберите Rename.

Измените имя требования на Hotel Reservations и нажмите Enter.

 4 Переместите требование Hotel Reservations в другое местоположение 
в дереве требований.

Правой кнопкой мыши щелкните требование Hotel Reservations и нажмите 
Cut.

Для вставки Hotel Reservations в качестве производного от требования 
Reservations Management щелкните правой кнопкой мыши Reservation 
Management и выберите Paste.
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Нажмите кнопку Yes для подтверждения. 

Совет. Требование также можно перетаскивать в новое место в дереве 
требований.

 5 Удалите требование Hotel Reservations.

Выделите Hotel Reservations.

Нажмите кнопку Delete. 

Нажмите кнопку Yes для подтверждения. Требование и его дочерние 
требования будут удалены.
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Преобразование требований
После создания дерева требований используйте требования в качестве 
основных сведений для определения дерева плана тестирования в 
модуле Test Plan. Дополнительные сведения см. в уроке «Разработка 
плана тестирования» на стр. 49.

Совет. Вы можете использовать управление качеством на основе рисков 
для анализа требований и использования анализа в качестве основы для 
планирования проведения тестирования. Дополнительные сведения об 
управлении качеством на основе риска см. в документе Руководство 
пользователя HP Quality Center.

Для помощи в разработке дерева плана тестирования можно использовать 
мастер Convert to Tests. Данный мастер позволяет преобразовывать 
выбранные требования или все требования в дереве требований в 
предметы или тесты в дереве плана тестирования.

В этом упражнении вы сможете преобразовать требование Cruise 
Reservation в предмет дерева плана тестирования, а дочернее требование 
Cruise Reservation в тесты тематической папки Cruise Reservation. 

Для преобразования требования:

 1 Убедитесь, что отображается модуль Requirements.

Если модуль Requirements не отображен, нажмите кнопку Requirements на 
боковой панели.

Выберите View > Requirements Tree для отображения требований в окне 
Requirements Tree.

 2 Выберите требование.

В дереве требований выберите Cruise Reservation. 
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 3 Запустите мастер преобразования требований в тесты.

Выберите Requirements > Convert to Tests. Откроется диалоговое окно 
Step 1.

 4 Выберите автоматическое преобразование.

Выберите второй параметр Convert lowest child requirements to tests, 
чтобы преобразовать выделенное требование в тематическую папку, а 
дочерние требования – в тесты.
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 5 Начните процесс преобразования.

Нажмите кнопку Next , чтобы начать преобразование требований. По 
завершении процесса преобразования результаты будут выведены в 
диалоговом окне Step 2.
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 6 Преобразуйте Cruise Search в шаг и сохраните его.

Чтобы преобразовать тест Cruise Search в шаг, выберите Cruise Search и 
нажмите кнопку Convert to Step. Тест Cruise Search преобразован в шаг.

Чтобы восстановить тест Cruise Search , выберите Cruise Search и 
нажмите кнопку Convert to Test. Шаг Cruise Search преобразован обратно 
в тест.

Нажмите кнопку Next. Откроется диалоговое окно Step 3.
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 7 Выберите путь к тематической папке.

В поле Destination Subject Path нажмите кнопку обзора. Откроется 
диалоговое окно Select Destination Subject.

В дереве плана тестирования выберите раздел Cruises.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Destination 
Subject. В поле Destination Subject Path теперь отображается следующий 
путь:

 8 Завершите процесс преобразования.

Нажмите кнопку Finish.

Нажмите кнопку OK.
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 9 Просмотрите тесты в дереве плана тестирования.

Для отображения модуля Test Plan нажмите кнопку Test Plan на боковой 
панели.

В дереве плана тестирования разверните Cruises. В дереве плана 
тестирования отобразится Cruise Reservation под Cruises. 

Разверните Cruise Reservation. В дереве плана тестирования отобразятся 
тесты Cruise Booking и Cruise Search.

Теперь, когда вы познакомились с процессом формулирования 
требований, просмотра и изменения дерева требований, а также 
преобразования требований, можно переходить к занятию Урок 4, 
«Разработка плана тестирования». В уроке 4 вы узнаете, как составить 
дерево плана тестирования. 
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4
Разработка плана тестирования

После формулировки требований необходимо определить цели 
тестирования. Для этого изучите приложение, системную среду и процесс 
тестирования для выбора стратегии, позволяющей достичь цели 
тестирования.  

После определения целей тестирования создается дерево плана 
тестирования, позволяющее иерархически разделить приложение на 
тестируемые модули или объекты. Для каждого объекта на дереве плана 
тестирования определяются тесты, состоящие из шагов.

Каждый шаг теста должен содержать описание действий, которые 
необходимо выполнить с приложением, и ожидаемый результат. Можно 
повысить универсальность шага теста путем добавления параметров.

Для отслеживания взаимосвязи между тестами и требованиями можно 
добавить связи между ними. Это поможет обеспечить соответствие 
требованиям в течение всего процесса тестирования. 

После разработки тестов можно выбрать те тесты, которые необходимо 
автоматизировать. В процессе автоматизации теста можно создать скрипт 
теста, а затем дополнить его другим средством тестирования HP 
(например, QuickTest Professional или WinRunner). 

Этот урок содержит следующие разделы. Стр.

Разработка дерева плана тестирования 50

Разработка шагов теста 53

Копирование шагов теста 57

Вызов тестов с параметрами 59
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Разработка дерева плана тестирования
Типичное приложение слишком велико, чтобы его тестировать целиком. 
Модуль Test Plan позволяет разбить приложение на функциональные 
составляющие. Приложение разбивается на блоки или объекты в 
процессе создания дерева плана тестирования. Дерево плана 
тестирования — это графическое представление плана тестирования, 
отображающее тесты в соответствии с иерархическими взаимосвязями 
между их функциями. Определив объекты на дереве, нужно решить, какие 
тесты нужно создать для этих объектов, а затем добавить тесты на дерево.

На уроке 3 вы преобразовывали требование Cruise Reservation и его 
дочерние требования в объекты и тесты на дереве плана тестирования 
(см. раздел «Преобразование требований» на стр. 43). В ходе этого 
упражнения вы добавите объект и тест к дереву плана тестирования в 
модуле Test Plan.

Примечание. Дерево плана тестирования можно создать непосредственно 
в Quality Center, а можно импортировать данные тестирования в проект 
Quality Center из Microsoft Word или Microsoft Excel. Для импорта из Word 
установите надстройки HP Quality CenterMicrosoft Word Add-in и 
HP Quality Center Connectivity Add-in. Для импорта из Excel установите 
надстройки HP Quality CenterMicrosoft Excel Add-in и HP Quality Center 
Connectivity Add-in. Загрузить эти надстройки можно со страницы 
надстроек HP Quality Center. Дополнительные сведения см. в документе 
Руководство по установке HP Quality Center.

Сведения о создании и просмотре требований 62

Разработка скриптов автоматизированных тестов 71

Этот урок содержит следующие разделы. Стр.
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Для разработки дерева плана тестирования:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в проект. 
Дополнительные сведения см. в разделе «Запуск Quality Center» на стр. 15.

 2 Отобразите модуль Test Plan.

Нажмите кнопку Test Plan на боковой панели. 

 3 Добавьте папку объектов в дерево плана тестирования.

Выберите папку объектов Cruises и нажмите кнопку New Folder. Откроется 
диалоговое окно New Folder.

В поле Folder Name введите Cruise Cancellation. Нажмите кнопку OK. На 
дереве плана тестирования под папкой Cruises появится созданная папка 
объектов. 

На правой панели на вкладке Description введите описание объекта: This 
folder contains tests that verify the Cancel Reservation functionality.

 4 Добавьте тест в папку объектов.

Выберите папку Cruise Cancellation и нажмите кнопку New Test. Откроется 
диалоговое окно Create New Test.

В поле Test Type выберите QUICKTEST_TEST для создания теста 
QuickTest Professional или выберите WR-AUTOMATED для создания теста 
WinRunner. 
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Примечание. 

➤ Тип теста QUICKTEST_TEST доступен только в том случае, если 
установлена надстройка HP QuickTest Professional Add-in со страницы 
HP Quality Center Add-ins. Подробные сведения об установке надстроек 
см. в документе Руководство по установке HP Quality Center.

➤ В случае выбора QUICKTEST_TEST из списка Test Type в диалоговом 
окне Create New Test станет доступным поле Template. Можно создать 
свой тест на основе другого теста QuickTest Professional, определенного 
в качестве шаблона. Quality Center копирует шаблон теста в новый тест 
без результатов тестирования. Дополнительные сведения о шаблонах 
тестов см. в документе Руководство пользователя HP Quality Center.

В поле Test Name введите имя теста: Cancel All Reservations. 

Нажмите кнопку OK. Откроется диалоговое окно Required Test Fields.

Установите следующие значения:

Level: Basic 

Reviewed: Not Reviewed

Priority: 4-Very High

Нажмите кнопку OK. 
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Новый тест появится в дереве плана тестирования под папкой объекта 
Cruise Cancellation.

 5 Добавьте описание теста.

На вкладке Details можно увидеть имя теста, кто автор, дату создания, 
состояние теста и другую информацию.

На вкладке Description введите описание теста: The test verifies 
cancellation of cruise reservations in the Itinerary page.

Разработка шагов теста
После добавления теста в дерево плана тестирования и формулировки 
основных сведений о тесте составляются подробные шаги теста, 
пошаговые инструкции, конкретизирующие способ его проведения. Шаг 
содержит описание действий, которые необходимо выполнить с 
приложением, и ожидаемых результатов.

Шаги теста можно создавать как для ручных, так и автоматизированных 
тестов. Для ручных тестов планирование теста завершается разработкой 
шагов теста. Используя план, можно сразу же начинать выполнение теста. 
Для автоматизированных тестов создаются скрипты для автоматических 
тестов с использованием средств тестирования HP, пользовательских 
средств тестирования, или средств тестирования сторонних 
производителей. 

В этом упражнении вы сможете создать тест Cruise Booking. Этот тест 
проверяет процесс бронирования круиза на сайте Mercury Tours. 
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Для разработки шага теста:

 1 Убедитесь, что отображается модуль Test Plan.

Если модуль Test Plan не отображен, нажмите кнопку Test Plan на боковой 
панели. 

 2 Отобразите тест Cruise Booking.

Разверните папки объектов Cruises и Cruise Reservation и выделите тест 
Cruise Booking.

 3 Откройте редактор Design Step Editor.

Нажмите вкладку Design Steps.

Нажмите кнопку New Step. Откроется редактор Design Step Editor. 

В поле Step Name отобразится имя шага. По умолчанию имя представляет 
собой порядковый номер шага теста (Step 1, если шаги добавляются к 
тесту впервые). 
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 4 Создайте шаг для отображения страницы Cruise Special. 

В редакторе Design Step Editor введите следующую информацию:

Step Name: Display the Cruise Special page. 

Description: Click the Cruises button. 

Expected Result: The Cruise Special page opens. 

 5 Создайте шаг для бронирования круиза.

В редакторе Design Step Editor нажмите кнопку New Step. В поле Step 
Name отобразится Step 2.

Введите следующее:

Step Name: Display the Cruise Reservation page.

Description: Click the Now Accepting Reservations button.

Expected Result: The Cruise Reservation page opens.
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 6 Создайте шаг для заказа билетов на круиз.

В редакторе Design Step Editor нажмите кнопку New Step. В поле Step 
Name отобразится Step 3.

Введите следующее:

Step Name: Book the cruise.

Description: Enter passenger name, credit card information, and address. Click 
OK. 

Expected Result: The Cruise Confirmation page opens.

 7 Создайте шаг для печати подтверждения информации по круизу.

В редакторе Design Step Editor нажмите кнопку New Step. В поле Step 
Name отобразится Step 4.

Введите следующее:

Step Name: Print cruise confirmation.

Description: Click the Print button. 

Expected Result: A confirmation page is printed.

 8 Создайте шаг для выхода с сайта Mercury Tours.

В редакторе Design Step Editor нажмите кнопку New Step. В поле Step 
Name отобразится Step 5.

Введите следующее:

Step Name: Log off.

Description: Click the Sign-Off button. 

Expected Result: Returns to the Sign-On page.
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 9 Закройте редактор Design Step Editor.

Нажмите кнопку OK. На вкладке Design Steps отобразятся созданные шаги.

Копирование шагов теста
Можно копировать шаги теста в одном проекте или из одного проекта в 
другой. В этом упражнении вы сможете копировать шаги из теста Cruise 
Booking и вставлять их в тест Cruise Search. 

Порядок копирования шага теста.

 1 Отобразите вкладку Design Steps теста Cruise Booking.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Booking.

Нажмите вкладку Design Steps.
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 2 Выберите шаги, которые нужно скопировать.

Наведите курсор мыши на серую боковую панель слева. Курсор изменится 
на стрелку. Нажмите кнопку Shift или Ctrl и выделите каждый шаг.

 3 Скопируйте выделенные шаги.

Нажмите кнопку Copy Steps.

 4 Вставьте шаги в тест Cruise Search.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Search.

В редакторе Design Step Editor нажмите кнопку Paste Steps. Шаги теста 
будут скопированы на вкладку Design Steps. 
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Вызов тестов с параметрами
При разработке шагов тестирования можно включить вызов ручного теста. 
В процессе выполнения теста шаги теста включают в себя шаги 
вызываемого теста. Вызываемый тест является тестом-шаблоном. Это 
тест многократного использования, выполнение которого могут 
инициировать другие тесты. Тест-шаблон может содержать параметры. 
Параметром является переменная, заменяющая фиксированное значение. 
Значение параметра можно изменять в соответствии с вызывающим его 
тестом или с различными объектами одного и того же теста. 

Например, предположим, что имеется тест по допуску пользователя с 
конкретным паролем в систему при запуске приложения. Необходимо 
вызывать этот тест в начале каждого теста. В некоторых случаях может 
потребоваться вход в систему в качестве обычного пользователя, а в 
других – вход с правами администратора. Чтобы этого добиться, создается 
два параметра: <<<имя пользователя>>> и <<<пароль>>>, и изменяется 
значение каждого параметра в соответствии с типом теста, который 
запускает тест-шаблон.

В разделе «Разработка шагов теста» на стр. 53 вы создавали тест для 
заказа билетов на круиз. В этом упражнении вы сможете 
усовершенствовать свой тест, запустив тест Connect And 
Sign-On. Этот тест-шаблон содержит параметры для URL-адреса Mercury 
Tours и имени пользователя и пароля, которые используются для входа на 
сайт.
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Для вызова теста с параметрами:

 1 Отобразите вкладку Design Steps теста Cruise Booking.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Booking.

Нажмите вкладку Design Steps.

 2 Выберите тест с параметрами, который нужно вызвать.

Нажмите кнопку Call to Test. Откроется диалоговое окно Select a Test.

В поле Find введите Connect и нажмите кнопку Find. Будет выделен тест 
Connect And Sign-On.
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Нажмите кнопку OK. Открывает диалоговое окно Parameters of Test, в 
котором отображаются параметры вызванного теста.

 3 Присвойте параметрам значения.

В столбце Value введите следующее:

mercury tours url: http://<имя сервера Quality Center>[:<номер 
порта>]/mtours

password: Оставьте пустым. Этому параметру присваивается значение во 
время выполнения теста (см. раздел «Выполнение тестов вручную» на 
стр. 93).

user name: Свое имя пользователя. Используйте то же самое имя, которое 
использовалось в Mercury Tours. Дополнительные сведения см. в разделе 
«Пример веб-сайта Mercury Tours» на стр. 21.

Нажмите кнопку OK. Шаг Connect And Sign-On добавлен к шагам проекта.
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 4 Измените последовательность шагов.

Наведите курсор мыши на серую боковую панель слева от шага 
Call Connect And Sign-On. Курсор изменится на стрелку. Нажмите и 
перетащите шаг в верхний ряд.

Сведения о создании и просмотре требований
Необходимо, чтобы тесты в плане тестирования соответствовали 
требованиям к тестированию. Для обеспечения соответствия на 
протяжении всего процесса тестирования можно добавлять связи между 
тестами модуля Test Plan и требованиями модуля Requirements.

В модуле Test Plan создается диапазон действия требований путем 
выбора требования для связи с тестом. Или в модуле Requirements 
необходимо создать тестовое покрытие путем выбора теста для связи с 
требованием. Тест может покрывать несколько требований, а требование 
может покрываться несколькими тестами.
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После регистрации дефектов в целях обеспечения дальнейшего 
соответствия требованиям к тестированию можно связать требования и 
тесты с дефектами (см. раздел «Связывание дефектов с тестами» на 
стр. 119). Это гарантирует, что при изменении какого-либо требования 
можно определить, какие тесты и дефекты будут затронуты, и кто за это 
несет ответственность.

В ходе этих упражнений вы узнаете о следующем.

➤ Связывании требований с тестами

➤ Связывание тестов с требованием

➤ Анализ тестового покрытия

Связывании требований с тестами
В этом упражнении можно будет увидеть существующее покрытие 
требований тестом Cruise Booking и создать новое покрытие требований, 
установив связь между требованием Cruise Search и тестом Cruise 
Booking. 

Вы также добавите покрытие требований к следующим тестам: Cancel All 
Reservations, Airline Preference и Number of Passengers.

Для связывания требования с тестом:.

 1 Убедитесь, что отображается модуль Test Plan.

Если модуль Test Plan не отображен, нажмите кнопку Test Plan на боковой 
панели. 

 2 Отобразите тест Cruise Booking.

Разверните папки объектов Cruises и Cruise Reservation и выделите тест 
Cruise Booking.

 3 Отобразите вкладку Req Coverage.

На правой панели щелкните вкладку Req Coverage. Существующий 
диапазон действия требований отобразится в таблице. Обратите 
внимание, что требование Cruise Booking уже связано с тестом Cruise 
Booking, поскольку вы преобразовали требование в тест (см. раздел 
«Преобразование требований» на стр. 43).
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 4 Отобразите дерево требований.

Нажмите кнопку Select Req и разверните дерево требований, 
отображенное справа.

 5 Добавьте в таблицу требование Cruise Search.

В дереве требований на правой панели под Cruise Reservation установите 
флажок Cruise Search. 

Нажмите кнопку Add to Coverage (Without Children). Требование Cruise 
Search будет добавлено в таблицу покрытия требований. 

Совет. Требование также можно перетащить из дерева требований в 
таблицу покрытия требований. Требование будет добавлено в таблицу 
покрытия требований без дочерних требований.

 6 Добавьте покрытие требований к тесту Cancel All Reservations.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Cancellation и выделите тест Cancel All Reservations.
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В дереве требований на правой панели под Cruise Reservation установите 
флажок Cruise Search и перетащите требование в таблицу покрытия 
требований. Выделите Cruise Booking и перетащите требование в 
таблицу покрытия требований.

 7 Добавьте покрытие требований к тесту Airline Preference.

В дереве плана тестирования разверните папки объектов Flight 
Reservation и Flight Finder и выделите тест Airline Preference.

В дереве требований на правой панели под Cruise Reservation установите 
флажок Cruise Search и перетащите требование в таблицу диапазона 
действия. Выделите Cruise Booking и перетащите требование в таблицу 
покрытия требований.

 8 Удалите покрытие требований из теста Airline Preference.

В таблице покрытия требований выберите Flight Tickets. Нажмите кнопку 
Remove Selected. Нажмите кнопку Yes для подтверждения.

Выделите Airline Company и нажмите кнопку Remove Selected. Нажмите 
кнопку Yes для подтверждения.

 9 Добавьте покрытие требований к тесту Number of Passengers.

В дереве плана тестирования разверните папки объектов Flight 
Reservation и Flight Finder и выделите тест Number of Passengers.

В дереве требований на правой панели под Cruise Reservation установите 
флажок Cruise Search и перетащите требование в таблицу диапазона 
действия. 

 10 Скройте дерево требований.

Нажмите кнопку Close.

Связывание тестов с требованием
В этом упражнении вы сможете создавать тестовое покрытие путем 
связывания теста Cruise Search с требованием Cruise Booking.

Для связывания теста с требованием:

 1 Отобразите модуль Requirements.

Нажмите кнопку Requirements на боковой панели. 
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 2 Отобразите дерево требований в виде Requirement Details View.

Выберите View > Requirement Details. Отобразится представление 
Requirements Details.

 3 Отобразите требование Cruise Booking.

В дереве требований разверните папку Cruise Reservation и выберите 
требование Cruise Booking.

 4 Перейдите на вкладку Test Coverage.

На правой панели щелкните вкладку Test Coverage. В таблице покрытия 
требований показано, что требование Cruise Booking уже связано со 
следующими тестами: Cruise Booking, Cancel All Reservations и Airline 
Preference.

 5 Отобразите дерево плана тестирования.

На вкладке Test Coverage нажмите кнопку Select Tests, чтобы открыть 
дерево плана тестирования в правой области. 

 6 Выберите тест Cruise Search в дереве плана тестирования.

На вкладке Test Plan Tree разверните папки объектов Cruises и Cruise 
Reservation и выделите тест Cruise Search.
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 7 Добавьте тест в таблицу диапазона действия.

Нажмите кнопку Add to Coverage. Тест Cruise Search будет добавлен в 
таблицу диапазона действия. 

Совет. Тест или объектную папку также можно перетащить из дерева Test 
Plan Tree в таблицу диапазона действия.

 8 Скройте дерево плана тестирования.

Нажмите кнопку Close над деревом плана тестирования.

Анализ тестового покрытия
После создания тестового покрытия можно использовать окно Coverage 
Analysis  модуля Requirements для анализа схемы организации дочерних 
требований в соответствии с тестовым покрытием. 

В этом упражнении вы проанализируете требование Application Client 
System. В окне Coverage Analysis можно увидеть, что два дочерних 
требования имеют статус “Failed” (не выполнены вследствие ошибок один 
или несколько тестов, покрытых требованием), а девять – статус “Not 
Covered” (требование не связано с тестом). Затем можно 
проанализировать требования со сбоями более подробно.

Для анализа тестового покрытия:

 1 Убедитесь, что отображается модуль Requirements.

Если модуль Requirements не отображен, нажмите кнопку Requirements на 
боковой панели.

 2 Отобразите дерево требований в виде Coverage Analysis.

Выберите View > Coverage Analysis. Отобразится представление 
Coverage Analysis. 
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 3 Отобразите требование Application Client System в окне Coverage 
Analysis.

Под требованием Mercury Tours Application разверните требование 
Application Client System и его производные.

В столбце Coverage Analysis видно, что из одиннадцати дочерних 
требований, имеющих статус прямого покрытия, только два имеют статус 
“Failed”, а девять – не покрыты тестами. Обратите внимание, что у 
требований Application Client System, Hardware, Monitor, Software, 
Operating System и Browser нет статуса прямого покрытия, поскольку они 
принадлежат к типам требований, не поддерживающим тестовое покрытие.
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 4 Отобразите анализ покрытия для требования Application Client 
System.

Правой кнопкой мыши щелкните требование Application Client System и 
выберите Coverage Analysis. Откроется диалоговое окно Coverage 
Analysis.

На этой диаграмме красным цветом показаны два требования со статусом 
“Failed” и белым цветом – девять требований со статусом “Not Covered”.

 5 Отобразите дочерние требования со статусом “Failed”.

Щелкните красную область Failed диаграммы. Будут перечислены 
дочерние требования со статусом “Failed”.

Обратите внимание, что можно выбрать требование и нажать кнопку Go 
To, чтобы выделить требование в дереве требований.
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 6 Отобразите тестовое покрытие для данного требования.

Щелкните ссылку Show Tests Coverage, чтобы отобразить диалоговое 
окно Coverage Analysis, содержащее диаграмму тестового покрытия. 

На диаграмме видно, например, что один из тестов (9,09%), связанных с 
требованием Application Client System, имеет статус “Failed”. Семь 
тестов, связанных с этим требованием, (63,64%) имеют статус “Passed”.

Обратите внимание, что можно щелкнуть сегмент диаграммы, чтобы 
открыть диалоговое окно Tests Coverage и отобразить список тестов с 
выбранным статусом.

 7 Закройте диалоговое окно Coverage Analysis.

Нажмите кнопку Close. 
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Разработка скриптов автоматизированных тестов
При разработке плана тестирования следует решить, какие тесты должны 
быть автоматизированы. Если будет принято решение выполнять тесты 
вручную, тесты будут готовы к выполнению сразу же после определения 
шагов тестирования. Если будет принято решение об автоматизации теста, 
можно создать скрипты теста, а затем дополнить их другими средствами 
тестирования HP (например, QuickTest Professional или WinRunner).

Рассмотрите эти вопросы в процессе принятия решения об автоматизации 
теста.

В этом упражнении вы научитесь создавать скрипты автоматизированного 
теста для теста Address Options.

Для разработки скрипта автоматизированного теста:

 1 Отобразите модуль Test Plan.

Нажмите кнопку Test Plan на боковой панели. 

Следует 
автоматизировать:

➤ Тесты, которые будут выполняться для каждой новой 
версии вашего приложения, чтобы проверить 
стабильность основных функциональных 
возможностей всего приложения (регрессионные 
тесты). 

➤ Тесты, использующие несколько значений данных 
для одной и той же операции (тесты, определяемые 
данными). 

➤ Тесты, которые выполняются многократно (стресс-
тесты), а также тесты, проверяющие 
многопользовательскую систему клиент-сервер 
(тесты на нагрузку ). 

Не следует 
автоматизировать:

➤ Тесты, выполняемые только один раз
➤ Тесты, требующие немедленного выполнения.
➤ Тесты, проверяющие, насколько легко использовать 

приложение (тесты на удобство и простоту 
использования).

➤ Тесты с непредсказуемыми результатами.
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 2 Найдите ручной тест Address Options.

Выберите корневую папку Subject дерева плана тестирования и выберите 
Edit > Find. Откроется диалоговое окно Find Folder/Test.

В поле Value To Find, введите Book.

Для поиска папок и тестов установите флажок Include Tests.

Нажмите кнопку Find. Откроется диалоговое окно Search Results со 
списком возможных совпадений.

Выберите папку Flight Reservation\Book Flight и нажмите кнопку Go To, 
чтобы выделить тест в дереве плана тестирования. Выберите тест 
Address Options.

Нажмите кнопку Close, чтобы закрыть диалоговое окно Search Results.

 3 Отобразите вкладку Design Steps.

На правой панели щелкните вкладку Search Results.

 4 Создайте скрипт теста.

Нажмите кнопку Generate Script.

Выберите QUICKTEST_TEST для создания теста с помощью средства 
тестирования QuickTest Professional или выберите WR-AUTOMATED для 
создания теста с помощью WinRunner.
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Примечание. Создать тест QUICKTEST_TEST можно только в том случае, 
если установлена надстройка HP QuickTest Professional add-in, которую 
можно загрузить со страницы надстроек HP Quality Center. Подробные 
сведения об установке надстроек см. в документе Руководство по 
установке HP Quality Center.

Шаги теста Address Options используются для создания скрипта 
автоматизированного теста. Обратите внимание, что в дереве плана 
тестирования ручные тесты с пиктограммой шагов  теперь заменены на 
пиктограмму автоматического теста.

 5 Просмотрите скрипт теста.

Нажмите вкладку Test Scripts.

Чтобы отобразить и изменить скрипт теста в средствах тестирования, в 
которых он был создан, нажмите кнопку Launch.

Теперь, когда вы познакомились с процессами создания дерева плана 
тестирования, создания и копирования шагов тестирования, вызова теста с 
параметрами, связывания тестов с требованиями, анализа тестового 
покрытия, а также автоматизации ручных тестов, можно переходить к 
занятию Урок 5, «Выполнение тестов». В уроке 5 вы узнаете, как запускать 
для выполнения ручные и автоматизированные тесты. 
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5
Выполнение тестов

Выполнение тестов являются основой процесса тестирования. При 
модификации приложения необходимо выполнять ручные и 
автоматизированные тесты, содержащиеся в проекте, для поиска 
дефектов в нем и оценки качества приложения.

Все начинается с создания наборов тестов и определения того, какие 
тесты следует включить в каждый набор. Набор тестов представляет собой 
группу тестов в проекте Quality Center, разработанную для достижения 
конкретных задач тестирования. Quality Center позволяет контролировать 
выполнение тестов из набора путем задания условий тестирования и 
составления расписания запуска тестов.

После определения наборов тестов можно приступить к выполнению 
тестов. Для просмотра и анализа результатов тестирования можно 
использовать Quality Center.

При выполнении теста вручную выполняются шаги теста, которые были 
определены в плане тестирования. Результат выполнения каждого шага 
теста зависит от того, соответствуют ли фактические результаты 
тестирования ожидаемым. Если выполняется автоматизированный тест, 
Quality Center открывает выбранное средство для тестирования, запускает 
тест, а затем импортирует результаты тестирования в Quality Center.

Этот урок содержит следующие разделы: Стр.

Определении набора тестов 76

Добавление тестов в набор 83

Составление расписания запуска тестов 86

Выполнение тестов вручную 93
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Определении набора тестов
После разработки тестов в модуле Test Plan можно создать дерево 
наборов тестов. Наборы тестов позволяют упорядочить процесс 
тестирования путем группирования наборов тестов в папках и 
распределения их по иерархическим уровням в модуле Test Lab. Каждая 
папка наборов тестов назначается циклу. Это позволяет группировать 
наборы тестов, которые будут выполняться во время одного и того же 
цикла, и анализировать прогресс цикла по мере выполнения тестов.

Набор тестов может содержать как ручные, так и автоматизированные 
тесты. Можно также включать экземпляры одного теста в различные 
наборы тестов, причем в один набор тестов можно включать несколько 
экземпляров одного и того же теста.

Принимая решение о том, какие наборы тестов необходимо создать, 
руководствуйтесь теми целями тестирования, которые вы определили в 
начале процесса тестирования. Следует учитывать такие вопросы, как 
текущее состояние приложения, добавление к нему новых функций и 
модификация уже существующих функций.

Просмотр и анализ результатов тестирования 100

Автоматическое выполнение тестов 105

Этот урок содержит следующие разделы: Стр.
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Ниже приведены примеры общих категорий наборов тестов, которые 
можно создавать.

В этом упражнении вы сможете определить набор тестов для сайта 
Mercury Tours. Вы также сможете задать правила для набора тестов с 
инструкциями для Quality Center, которые должны выполняться в случае 
отрицательного результата автоматизированного теста из набора. 

Процедура определения набора тестов.

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, зарегистрируйтесь в нем. 
Дополнительные сведения см. в разделе «Запуск Quality Center» на стр. 15.

Набор тестов Описание 

Работоспособн
ость

Проверяет всё приложение на базовом уровне, его 
работоспособность и стабильность. При этом главное 
внимание уделяется широте, а не глубине проверки. Этот 
набор тестов содержит основные тесты, в том числе 
"положительные" проверки, то есть проверки, которые 
показывают, что приложение работает правильно. 
Например, при проверке приложения Mercury Tours можно 
проверить, открывается ли оно и позволяет ли выполнить 
вход в него.

Регрессия Система тестируется глубже, чем при поверхностной 
проверке работоспособности. Этот набор тестов содержит 
как 'положительные', так и 'отрицательные' проверки. 
Отрицательной проверкой называется попытка найти 
ошибку в приложении, чтобы показать, что оно работает 
неправильно.

Расширенный Приложение тестируется как в ширину, так и в глубину. Этот 
набор тестов позволяет проверить всё приложение, в том 
числе его дополнительные функции. Выполнить этот набор 
тестов можно в случае, если на тестирование выделено 
достаточно много времени.

Функционально
сть

Тестируется подсистема приложения. Это может быть одна 
функция или группа функций. Например, при проверке 
приложения Mercury Tours можно проверить все действия, 
связанные с бронированием билетов на авиарейс. 
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 2 Отобразите модуль Test Lab.

Нажмите кнопку Test Lab на боковой панели.

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 3 Добавьте папку на дереве набора тестов.

В дереве набора тестов на левой панели выберите папку Root.

Нажмите кнопку New Folder. Откроется диалоговое окно New Folder.

В поле Folder Name введите Service Pack 1 и нажмите OK. 

 4 Создайте вложенные папки в папке с наборами тестов. 

Выделите созданную папку Service Pack 1 и повторите предыдущий шаг 
для создания двух вложенных папок с именами Cycle 1 - New Features и 
Cycle 2 - Full.

 5 Назначьте папку наборов тестов циклу.

Выделите папку с набором тестом Cycle 1 - New Features и нажмите кнопку 
Assign to Cycle. Откроется диалоговое окно Assign to Cycle. В папке 
релизов Service Packs релизе Service Pack 1 выделите цикл Cycle 1 - New 
Features. Чтобы закрыть дерево релизов, нажмите кнопку OK. 
Пиктограмма папки в дереве наборов тестов изменится и покажет, что 
папка назначена циклу.
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Назначьте папку с наборами тестов Cycle 2 - Full циклу Cycle 2 - Full, 
который находится в папке релизов Service Pack 1 в дереве релизов.

 6 Добавьте набор тестов в папку с наборами тестов Cycle 1 - New 
Features.

В дереве наборов тестов выделите Cycle 1 - New Features.

Нажмите кнопку New Test Set. Откроется диалоговое окно New Test Set.

Введите следующее:

Test Set Name: Mercury Tours Site

Description: This test set includes tests that verify the functionality of the 
Mercury Tours site.

Нажмите кнопку OK. Папка с наборами тестов Mercury Tours Site 
добавится к дереву наборов тестов в левой области.
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 7 Сформулируйте подробные сведения о наборах тестов.

Перейдите на вкладку Test Set Properties и щелкните ссылку Details. 

По умолчанию в поле Status показывается, что набор тестов относится к 
типу Open. 

Выполните следующие действия:

Open Date: Выберите календарную дату, запланированную для начала 
набора тестов.

Close Date: Выберите планируемую дату закрытия набора тестов.
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 8 Задайте правила для автоматизированных тестов из набора тестов, 
которые должны выполняться в случае отрицательного результата 
тестирования. 

Нажмите ссылку On Failure.

Выполните следующие действия: 

On automated test failure: Установите флажок в первом поле и убедитесь, 
что в числе повторного выполнения автоматизированных тестов указано 1. 

On final test failure: Убедитесь, что выделен параметр Do nothing.
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 9 Дайте Quality Center инструкции разослать сообщения по электронной 
почте указанным пользователям в случае тех или иных событий.

Щелкните ссылку Notifications. 

Выполните следующие действия:

Send e-mail in the event of: Установите первый флажок, чтобы отправить 
уведомление по электронной почте в случае сбоя любого теста из набора. 

To: Введите свой адрес электронной почты.

Message: Введите следующее: 
This test failed. Please review the test results and submit a defect. 
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Добавление тестов в набор
После определения набора тестов в него можно добавлять тесты. В этом 
упражнении вы сможете добавить тесты в набор тестов Mercury Tours 
Site. 

Процедура добавления теста в набор тестов.

 1 Убедитесь, что отображается модуль Test Lab.

Если модуль Test Lab не отображен, нажмите кнопку Test Lab на боковой 
панели. 

Если на экран не отображено окно Test Sets Tree, выберите View > Test 
Sets Tree.

 2 Отобразите вкладку Execution Grid.

В дереве набора тестов раскройте папку с наборами тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 

Перейдите на вкладку Execution Grid.
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 3 Отобразите дерево плана тестирования, если оно еще не отображено.

Нажмите кнопку Select Tests. На правой панели отобразится дерево плана 
тестирования.

Примечание. Если применяются фильтры, рекомендуется их очистить.

➤ В дереве плана тестирования нажмите стрелку Set Filter/Sort и 
выберите Clear Filter/Sort. Нажмите кнопку Yes для подтверждения.

➤ На вкладке Execution Grid нажмите стрелку Set Filter/Sort и выберите 
Clear Filter/Sort. Нажмите кнопку Yes для подтверждения.

 4 Добавьте папку Cruises в дерево набора тестов. 

В дереве плана тестирования выберите папку Cruises и нажмите кнопку 
Add Tests to Test Set. 
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Нажмите кнопку Yes для подтверждения. Откроется диалоговое окно 
Parameters of Test, поскольку в набор тестов добавляется тест со 
значением параметра, которое не назначено. Чтобы закрыть диалоговое 
окно, нажмите кнопку Cancel. Этому параметру присваивается значение во 
время выполнения теста Cruise Booking (см. «Выполнение тестов вручную» 
на стр. 93). Тесты добавятся в дерево наборов тестов.

 5 Добавьте тест Airline Preference в набор.

Для поиска теста в поле Find введите airline и нажмите кнопку Find. Тест 
Airline Preference будет выделен на дереве плана тестирования.

Нажмите кнопку Add Tests to Test Set. Тест добавится в набор тестов.

 6 Добавьте тест Number of Passengers в набор тестов.

Для поиска теста в поле Find введите Number of Passengers и нажмите 
кнопку Find. Тест Number of Passengers будет выделен на дереве плана 
тестирования.

Нажмите кнопку Add Tests to Test Set. Тест добавится в набор тестов.

 7 Закройте дерево плана тестирования.

Нажмите кнопку Close. 
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Составление расписания запуска тестов
На вкладке Execution Flow можно указать дату, время и условия 
выполнения теста. В основе условия лежат результаты выполнения 
другого теста, заданного в схеме выполнения. Задавая условия, можно 
отложить выполнение теста до завершения или успешного выполнения 
другого теста. Также можно установить последовательность выполнения 
тестов. 

Например, можно запланировать запуск теста Test 2 только после 
окончания теста Test 1, а запуск теста Test 3 только после успешного 
выполнения теста Test 2. Также можно установить дату запуска тестов Test 
1 и Test 2 за день до теста Test 3. На вкладке Execution Flow тесты и их 
условия будут отображены в виде диаграммы. 
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Примечание. 

➤ Стрелка с пунктирной линией обозначает тест без условий. 

➤ Сплошная линия со стрелкой обозначает условие, она 
может быть синей или зеленой. Если сплошная линия синего цвета, это 
означает, что задано условие “Finished”. Если сплошная линия зеленого 
цвета, это означает, что задано условие “Passed”.

➤ Рядом с тестами, имеющими временную зависимость, отображается 
пиктограмма Time Dependency .

В ходе этого упражнения вы сможете создать новый набор тестов и 
добавить его к трем тестам, подтверждающим процедуру входа на 
страницу регистрации сайта Mercury Tours. Затем вы зададите условия для 
каждого теста и определите время их выполнения. 

Как составить план выполнения тестов

 1 Убедитесь, что отображается модуль Test Lab.

Если модуль Test Lab не отображен, нажмите кнопку Test Lab на боковой 
панели. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Создайте новый набор тестов.

В модуле Test Lab перейдите на вкладку Execution Flow. 
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В дереве набора тестов выделите папку Service Pack 1 и нажмите кнопку 
New Test Set. Откроется диалоговое окно New Test Set.

Введите следующее:

Test Set Name: Test Run Schedule

Description: This test set is used to explain how to schedule a test run.

Нажмите кнопку OK. Набор тестов Test Run Schedule добавится в дерево 
наборов тестов в левой области. 

 3 Добавьте тест из папки Sign-On/Sign-Off к набору тестов Test Run 
Schedule.

Если дерево плана тестирования не открыто, нажмите кнопку Select Tests. 
Дерево плана тестирования отобразится в правой области.

В поле Find дерева плана тестирования введите sign и нажмите кнопку 
Find для поиска папки Sign-On/Sign-Off. Папка Sign-On/Sign-Off будет 
выделена в дереве плана тестирования.

Выделите тест Sign-On Page. Нажмите кнопку Add Tests to Test Set. 
Откроется диалоговое окно Parameters of Test, поскольку в набор тестов 
добавляется тест со значением параметра, которое не назначено. Чтобы 
закрыть диалоговое окно, нажмите кнопку Cancel. Тест добавится в набор 
тестов.
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 4 Добавьте два дополнительных теста в набор.

Перетащите тест Sign-On User Name в область Execution Flow. Откроется 
диалоговое окно Parameters of Test. Нажмите кнопку Cancel.

Дважды щелкните тест Sign-On Password, чтобы добавить его в область 
Execution Flow. Откроется диалоговое окно Parameters of Test. Нажмите 
кнопку Cancel.

 5 Добавьте условие выполнения теста Sign-On User Name.

Правой кнопкой мыши щелкните тест Sign-On User Name и выберите Test 
Run Schedule. Откроется диалоговое окно Run Schedule, содержащее 
вкладку Execution Conditions. 
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Нажмите New. Откроется диалоговое окно New Execution Condition.

В поле Test выделите тест <[1]Sign-On Page>.

Выберите Passed, чтобы указать Quality Center выполнить тест Sign-On 
User Name, только если тест Sign-On Page  будет успешно завершен.

Нажмите кнопку OK. Условие будет добавлено в диалоговое окно Run 
Schedule.
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 6 Добавьте условие зависимости теста Sign-On User Name от времени.

Перейдите на вкладку Time Dependency.

Под пунктом Run At Specified Time, поставьте дату в поле Date и выберите 
завтрашнюю дату.

Чтобы закрыть диалоговое окно Run Schedule, нажмите кнопку OK. 
Условия отобразятся в схеме выполнения Execution Flow.

 7 Добавьте условие выполнения теста Sign-On Password.

Добавьте то же самое условие как указано в шаге 5 на странице 89 для 
теста Sign-On Password. На этот раз выберите тест Sign-On User Name из 
поля Test в диалоговом окне New Execution Condition.
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 8 Добавьте условие временной зависимости тесту Sign-On Password.

Добавьте то же самое условие временной зависимости, которое описано в 
шаге 6 на странице 91 для теста Sign-On Password.

Чтобы закрыть диалоговое окно Run Schedule, нажмите кнопку OK. 
Условия отображаются в схеме выполнения Execution flow.

 9 Реорганизуйте тесты в иерархической компоновке.

Щелкните мышью кнопку Arrange Layout.
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Выполнение тестов вручную
При выполнении теста вручную выполняются шаги тестов и операции с 
приложением. Затем фактические результаты нужно записать и сравнить с 
ожидаемыми. Один и тот же ручной тест можно выполнять неограниченное 
количество раз. При этом отдельно сохраняются результаты каждого 
выполнения теста. 

Вручную можно выполнять как ручные, так и автоматизированные тесты. 
Можно также выполнить один тест или весь набор тестов.

В этом упражнении вы сможете выполнить тесты Cruise Booking и Cruise 
Search.

Процедура выполнения теста вручную.

 1 Убедитесь, что отображается модуль Test Lab.

Если модуль Test Lab не отображен, нажмите кнопку Test Lab на боковой 
панели. Перейдите на вкладку Execution Grid. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Выделите набор тестов Mercury Tours Site.

В дереве набора тестов разверните папку с наборами тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 
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 3 Выберите тест Cruise Booking из таблицы Execution Grid.

На вкладке Execution Grid выберите Cruise Booking.

Нажмите кнопку Run. Откроется диалоговое окно Manual Runner.
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 4 Запустите тест.

Нажмите кнопку Begin Run. Откроется диалоговое окно Parameters Values 
for Run, поскольку тест содержит параметр, который не назначен
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 5  Присвойте значение параметру пароля.

Щелкните поле Value для пароля и введите тот же самый пароль, который 
использовался для Mercury Tours. Дополнительные сведения см. в разделе 
«Пример веб-сайта Mercury Tours» на стр. 21.

Нажмите кнопку OK. Manual Runner: откроется диалоговое окно Details.
96



Урок 5 • Выполнение тестов
 6 Откройте диалоговое окно Manual Runner в компактном виде. 

Нажмите кнопку Compact view. Оно позволяет прочитывать каждый шаг и 
записывать результаты.

 7 Выполните первый шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат совпадает с ожидаемым результатом в поле 
Actual введите: The Mercury Tours site opens.

Нажмите кнопку Pass Selected. Отобразится шаг 2.

 8 Выполните второй шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат совпадает с ожидаемым результатом в поле 
Actual введите: The Flight Finder page opens.

Нажмите кнопку Pass Selected. Отобразится шаг 3.
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 9 Выполните третий шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат совпадает с ожидаемым результатом в поле 
Actual введите: The Cruise Special page opens.

Нажмите кнопку Pass Selected. Отобразится шаг 4.

 10 Выполните четвертый шаг.

Выполните процедуру, изложенную в поле Description.

Если полученный результат отличается от ожидаемого результата в поле 
Actual введите: The Flight Finder page opens instead of the Cruise 
Reservation page.

Нажмите кнопку Fail Selected. 

Примечание. При обнаружении дефекта приложения во время 
выполнения теста можно нажать кнопку New Defect, чтобы открыть 
диалоговое окно New Defect и добавить дефект. В этом упражнении этот 
дефект будет отправлен в «Добавление новых дефектов» на стр. 111.

 11 Вернитесь к исходному окну Manual Runner.

Нажмите кнопку Back to Steps Grid. Исходное окно Manual Runner: 
отображается диалоговое окно Step Details. 

 12 Завершите выполнение теста.

Нажмите кнопку End Run для завершения выполнения теста.

 13 Выполните тест Cruise Search.

На вкладке Execution Grid выберите тест Cruise Search и нажмите кнопку 
Run. Откроется Manual Runner.

Выполните шаги теста, как в случае с тестом Cruise Booking, но на этот 
раз пройдите каждый шаг.
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 14 Просмотрите результаты выполнения теста в таблице Execution Grid.

После выполнения тестов можно просмотреть результаты последнего 
выполненного теста на вкладке Execution Grid. Обратите внимание, что 
статус теста Cruise Booking обновился с “No Run” до “Failed”, а статус 
теста Cruise Search - с “No Run” до “Passed”.

 15 Просмотрите результаты каждого шага тестирования в области Last 
Run Result.

Выберите тест Cruise Booking. Если панель Last Run Result не 
отображена, нажмите кнопку Show внизу панели. Панель Last Run Result 
отобразится под вкладкой Execution Grid.

Щелкните каждый шаг, чтобы просмотреть его описание, а также 
ожидаемые и реальные результаты.
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Просмотр и анализ результатов тестирования
Quality Center имеет ряд функций, которые позволяют просматривать и 
анализировать результаты тестирования.

Подробные результаты тестирования отображаются в диалоговом окне 
Test Instance Properties. Они включают в себя подробности выполнения 
теста, приложения, связанные дефекты и журнал.

Ранее вы узнали, как можно использовать окно Coverage Analysis для 
анализа распределения дочерних требований в соответствии с покрытием 
тестами (см. раздел «Анализ тестового покрытия» на стр. 67). Можно 
отфильтровать тесты, которые содержатся в данном вычислении, по циклу. 
Quality Center включает в вычисление только те тесты, которые входят в 
наборы тестов, находящиеся под папками наборов тестов и назначенные 
циклам, которые соответствуют фильтру. Например, предположим 
планируется провести тестирование требования по нескольким циклам 
релиза. Может потребоваться анализ покрытия требования только теми 
тестами, которые запланированы на текущий цикл. В этом случае следует 
отфильтровать покрытие требований по текущему циклу.

Ранее вы познакомились с функциями вкладки Progress модуля Releases 
(см. раздел «Просмотр релизов и циклов» на стр. 28). После выполнения 
тестов модуля Test Lab можно снова перейти на эту вкладку и посмотреть, 
как изменяются  диаграммы и статистика при изменении статуса тестов для 
релизов и циклов. Это позволяет просматривать обзор процесса создания 
релиза на высоком уровне.

Кроме этих функций можно воспользоваться отчетами и диаграммами 
Quality Center для углубленного анализа результатов теста. Подробнее см. 
Урок 8, «Анализ процесса тестирования».

В этом упражнении вы сможете просмотреть подробные результаты и 
анализы тестов, выполненных в предыдущих упражнениях.

Процедура просмотра и анализа результатов теста.

 1 Убедитесь, что отображается модуль Test Lab.

Если модуль Test Lab не отображен, нажмите кнопку Test Lab на боковой 
панели. 
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Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.

 2 Отобразите набор тестов Mercury Tours Site на вкладке Execution Grid.

Перейдите на вкладку Execution Grid.

В дереве набора тестов разверните папку с наборами тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 

 3 Выберите тест Cruise Booking из таблицы Execution Grid.

На вкладке Execution Grid выберите Cruise Booking.

 4 Просмотрите подробные результаты тестирования в диалоговом 
окне Test Instance Properties.

Нажмите кнопку Test Instance Properties. Откроется диалоговое окно Test 
Instance Properties и отобразит представление All Runs.
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 5 Просмотрите информацию о других результатах тестирования в 
диалоговом окне Test Instance Properties.

➤ Чтобы просмотреть подробные сведения о выполнении теста нажмите 
Details.

➤ Чтобы просмотреть параметры теста, задаваемые вручную, щелкните 
Configuration и выберите вкладку Manual. Обратите внимание, что все 
вносимые изменения будут реализованы во время следующего 
выполнения теста.

➤ Чтобы просматривать и связывать дефекты с объектами Quality Center, 
нажмите Linked Defects.

➤ Чтобы просмотреть список изменений внесенных в поля выполнения 
теста, нажмите History.

 6 Закройте диалоговое окно Test Instance Properties.

Нажмите кнопку Close.

 7 Отобразите модуль Requirements в представлении Coverage Analysis

Нажмите кнопку Requirements на боковой панели.

Выберите View > Coverage Analysis.

 8 Отфильтруйте тесты, входящие в анализ покрытия, по циклу.

В верхнем правом углу окна нажмите кнопку обзора в поле Coverage 
calculation by cycle.

В дереве релизов раскройте папку релиза Service Packs и релиза Service 
Pack 1. Установите флажок Cycle 1 - New Features и нажмите OK.
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Разверните требование Cruise Reservation. В столбце Coverage Analysis 
видно, что при тестировании обоих требований нижнего уровня произошел 
сбой.

 9 Откройте модуль Releases.

Нажмите кнопку Releases на боковой панели.
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 10 Просмотрите результаты выполнения тестов на вкладке Progress.

В дереве релизов разверните папку релиза Service Packs и релиза Service 
Pack 1. Выделите Cycle 1 - New Features. Выберите вкладку Progress.

Через день после начала цикла Cycle 1 - New Features видно, что из 
осталось выполнить 3 экземпляра теста из пяти. Под диаграммой 
выполнения покрытия требований кривая Planned coverage показывает, 
что тесты полностью (100%) покрывают все назначенные требования. 
Кривая Executed coverage показывает, что было выполнено 40% тестов. 
Кривая Passed coverage показывает, что выполнение 20% тестов 
завершилось успешно.
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Автоматическое выполнение тестов
Если выполняется автоматизированный тест, Quality Center автоматически 
открывает выбранное средство тестирования, запускает тест на вашем 
локальном компьютере или на удаленном хосте, а затем импортирует 
результаты тестирования в Quality Center. 

Обратите внимание, что можно запускать все тесты из набора тестов или 
только выбранные тесты. Выполнять можно тесты, выбранные на вкладке 
Execution Grid или на вкладке Execution Flow. 

В этом упражнении вы сможете выполнить автоматизированный тест из 
набора тестов Mercury Tours Site.

Примечание. Чтобы выполнить это упражнение, на компьютере должно 
быть установлено приложение QuickTest Professional или WinRunner.

➤ Для интеграции Quality Center с QuickTest Professional необходимо 
установить надстройки HP QuickTest Professional и HP Quality Center 
Connectivity, которые можно загрузить со страницы надстроек 
HP Quality Center. 

➤ Для интеграции Quality Center с WinRunner необходимо установить 
надстройку HP Quality Center Connectivity, которую можно загрузить со 
страницы надстроек HP Quality Center.

Дополнительные сведения см. в документе Руководство по установке 
HP Quality Center.

Процедура выполнения автоматизированного теста.

 1 Убедитесь, что отображается модуль Test Lab.

Если модуль Test Lab не отображен, нажмите кнопку Test Lab на боковой 
панели. 

Выберите View > Test Sets Tree, чтобы отобразить наборы тестов в дереве 
наборов тестов.
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 2 Отобразите набор тестов Mercury Tours Site на вкладке Execution Grid.

Перейдите на вкладку Execution Grid.

В дереве набора тестов разверните папку с наборами тестов Cycle 1 - New 
Features под папкой Service Pack 1. Выделите набор тестов Mercury 
Tours Site. 

 3 Выберите тест.

Для выполнения теста WinRunner выберите Airline Preference. 

Для выполнения теста QuickTest Professional выберите Number of 
Passengers.

Нажмите кнопку Run. Откроется диалоговое окно Automatic Runner, в 
котором будет отображен выбранный тест.

 4 Задайте настройки для выполнения теста.

Установите флажок Run All Tests Locally для выполнения теста на 
локальном компьютере.
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 5 Выполните тест.

Нажмите кнопку Run. Quality Center автоматически откроет выбранное 
средство тестирование и выполнит тест. Ход выполнения теста 
отображается в столбце Status.

 6 Закройте диалоговое окно Automatic Runner.

После завершения выполнения теста выберите Run >Exit.
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 7 Просмотрите сводку результатов выполнения теста на вкладке 
Execution Grid. 

На вкладке Execution Grid отображается обновленное состояние 
выполнения теста. Результаты каждого шага теста отображаются в 
области Last Run Result.

 8 Закройте выбранное средство тестирования.

В приложении QuickTest Professional или WinRunner выберите File >Exit.

Теперь, когда вы познакомились с процессами формулирования и 
создания наборов тестов, составления расписания запуска тестов, 
выполнения тестов вручную или автоматически, а также просмотра и 
анализа требований, можно переходить к занятию Урок 6, «Добавление и 
отслеживание дефектов». В уроке 6 вы узнаете, как добавлять и 
отслеживать дефекты.
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Добавление и отслеживание дефектов

Важной частью процесса разработки является выявление и устранение 
дефектов в приложениях. Разработчики и тестировщики могут 
обнаруживать и регистрировать дефекты на всех этапах процесса 
тестирования. С помощью Quality Center можно регистрировать дефекты, 
обнаруженные в приложении, и отслеживать их до их устранения или 
повторного тестирования приложения. 

Этот урок содержит следующие разделы: Стр.

Отслеживание дефектов 110

Добавление новых дефектов 111

Сопоставление дефектов 113

Обновление дефектов 115

Связывание дефектов с тестами 119

Создание представления Favorite. 122
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Отслеживание дефектов
При регистрации дефекта в проекте Quality Center процесс его 
отслеживания включает следующие этапы. New, Open, Fixed и Closed. 
Дефект может также быть Rejected или Reopened после его устранения.

При первоначальном предоставлении сведений о дефекте в Quality Center 
ему по умолчанию присваивается статус New. Менеджер по контролю 
качества или руководитель проекта изучает дефект и определяет, следует 
ли его устранять.  Если дефект отклоняется, ему присваивается статус 
Rejected. Если дефект необходимо устранить, менеджер по контролю 
качества или руководитель проекта определяет приоритеты его 
устранения, изменяет его статус на Open и поручает устранить дефект 
члену группы разработки приложений. Разработчик устраняет дефект и 
присваивает ему статус Fixed. Пользователь повторно тестирует 
приложение, после чего он проверяет, что дефект устранен. 

Если дефект возникает повторно, менеджер по контролю качества или 
руководитель проекта присваивает ему статус Reopened. Если дефект 
устранен, менеджер по контролю качества или руководитель проекта 
присваивает ему статус Closed.
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Добавление новых дефектов
Добавить новый дефект в проект Quality Center можно на любом этапе 
процесса тестирования. В этом упражнении вы сможете добавить дефект, 
обнаруженный при выполнении теста Cruise Booking.

Примечание. Кроме добавления дефектов непосредственно в 
Quality Center также можно импортировать данные о дефектах из Microsoft 
Excel в проект Quality Center. Для импорта из Excel установите надстройки 
HP Quality Center Microsoft Excel Add-in и HP Quality Center Connectivity 
Add-in. Загрузить эти надстройки  можно со страницы надстроек  
HP Quality Center. Дополнительные сведения см. в документе Руководство 
по установке HP Quality Center.

Для добавления нового дефекта выполните следующие действия.

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, войдите в проект. 
Дополнительные сведения см. в разделе «Запуск Quality Center» на стр. 15.

 2 Отобразите модуль Defects.

Нажмите кнопку Defects на боковой панели. На вкладке Defects Grid 
отображаются данные о дефектах в виде таблицы. В каждой строке этой 
таблицы отображаются данные по конкретному дефекту.
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 3 Откройте диалоговое окно New Defect.

Нажмите кнопку New Defect. Откроется диалоговое окно New Defect.

 4 Введите описание дефекта.

Введите или выберите следующее:

Summary: Unable to reserve a cruise from the Cruise page. 

Category: Defect

Severity: 2-Medium 

Subject: Cruises 

Description:  The defect was detected in the Cruise Booking test. When you 
click the Now Accepting Reservations button, the Flight Finder page opens 
instead of the Cruise Reservation page.
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 5 Определите цикл, в котором был обнаружен дефект.

В поле Detected in Cycle нажмите кнопку обзора. Откроется дерево 
релизов. Разверните дерево. В папке релизов Service Packs релизе 
Service Pack 1 выделите цикл Cycle 1 - New Features. 

Видно, что Quality Center автоматически присваивает значение Service 
Pack 1 полю Detected in Release. Это происходит, потому что цикл Cycle 1 
- New Features составляет часть релиза Service Pack 1.

Чтобы закрыть дерево релизов, нажмите кнопку OK.

 6 Присоедините URL-адрес к странице Mercury Tours, на которой 
обнаружен дефект.

Нажмите кнопку Attach URL. Откроется диалоговое окно Attach Uniform 
Resource Locator (URL). 

Введите URL-адрес страницы Mercury Tours. 
http://<Quality Center имя сервера>/mtours

Нажмите кнопку OK. URL будет отображен над полем Description.

 7 Добавьте дефект в проект Quality Center.

Нажмите кнопку Submit. Дефект добавится в таблицу Defects Grid.

 8 Закройте диалоговое окно New Defect.

Нажмите кнопку Close.

Сопоставление дефектов
Сопоставление дефектов позволяет устранять в проекте дубликаты 
дефектов или аналогичные дефекты. При каждом добавлении нового 
дефекта Quality Center сохраняет списки ключевых слов из полей Summary 
и Description. При поиске аналогичных дефектов ключевые слова из этих 
полей сопоставляются с другими дефектами. Обратите внимание, что 
ключевые слова должны содержать больше двух символов, и регистр букв 
на результаты не влияет.

В этом упражнении вы сможете сопоставлять дефекты путем сравнения 
выбранного дефекта со всеми остальными дефектами проекта 
QualityCenter_Demo. 
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Порядок сопоставления дефектов.

 1 Убедитесь, что отображается модуль Defects.

Если модуль Defects не отображается, нажмите кнопку Defects на боковой 
панели. 

 2 Выберите Defect ID 37.

В таблице Defects Grid выберите Defect ID 37. 

Примечание. Если невозможно обнаружить Defect ID 37, щелкните 
стрелку Set Filter/Sort и выберите команду Clear Filter/Sort, чтобы 
очистить фильтр, примененный к таблице.

 3 Найдите аналогичные дефекты.

Нажмите кнопка Find Similar Defects.

Результаты сохраняются в диалоговом окне Similar Defects, упорядоченные 
в соответствии с процентом обнаруженного сходства. Обратите внимание, 
что в проекте для выбранного дефекта нет дублирующих дефектов.
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Чтобы закрыть диалоговое окно Similar Defects, нажмите кнопку Close.

Обновление дефектов
Отслеживание устранения дефектов в проекте требует периодического 
обновления дефектов. Данную операцию можно выполнить напрямую в 
таблице Defects Grid или в диалоговом окне Defect Details. Обратите 
внимание, что способность обновлять поля некоторых дефектов зависит от 
настроек доступа. После обновления дефектов можно просмотреть 
текущее состояние качества релиза в модуле Release.

В этом упражнении информация о дефекте будет обновлена путем 
изменения уровня серьезности дефекта, назначением дефекта циклу и 
добавлением комментария. Затем вы увидите как отображаются 
обновленные дефекты на вкладке Quality модуля Releases.

Для обновления дефектов выполните следующие действия.

 1 Убедитесь, что отображается модуль Defects.

Если модуль Defects не отображается, нажмите кнопку Defects на боковой 
панели. 
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 2 Откройте диалоговое окно Defect Details.

В таблице Defects выберите дефект, добавленный в «Добавление новых 
дефектов» на стр. 111. Нажмите кнопку Defect Details. Откроется 
диалоговое окно Defect Details. 

 3 Измените уровень серьезности дефекта.

В поле Severity выберите 5-Urgent.

 4 Определите цикл, в котором будет устранен дефект.

В поле Target Cycle нажмите кнопку обзора. Откроется дерево релизов. 
Разверните дерево. В папке релизов Service Packs в релизе Service Pack 
1 выделите цикл Cycle 2 - New Features. 

Видно, что Quality Center автоматически присваивает значение Service 
Pack 1 полю Target Release. Это происходит, потому что цикл Cycle 2 - Full 
является частью релиза Service Pack 1.

Чтобы закрыть дерево релизов, нажмите кнопку OK.
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 5 Добавьте новый комментарий, чтобы объяснить изменения в уровне 
серьезности дефекта.

Нажмите кнопку Add Comment. Новый раздел будет добавлен в поле 
Comments с именем пользователя и текущей датой.

Введите: This defect should be fixed in the next service pack.

 6 Просмотрите вложения.

Нажмите кнопку Attachments на боковой панели. Обратите внимание, что 
перечислено вложение URL.

 7 Просмотрите связанные объекты.

Щелкните Linked Entities на боковой панели, чтобы просмотреть объекты, 
связанные с дефектом. Связанными объектами могут быть требования, 
тесты, наборы тестов, экземпляры тестов, выполнения тестов, шаги 
выполнения и другие дефекты. На данный момент связанные объекты 
отсутствуют. Вы научитесь связывать дефект с тестом в разделе 
«Связывание дефектов с тестами» на стр. 119.

 8 Просмотрите журнал.

Щелкните History на боковой панели, чтобы просмотреть историю 
изменений, внесенных в дефект. Для каждого изменения в таблице 
отображается дата и время изменения, а также имя пользователя, 
внесшего изменение. Можно развернуть изменение, чтобы просмотреть 
список измененных полей. Для каждого поля в таблице отображаются 
старое и новое значения.

 9 Закройте диалоговое окно Defect Details.

Нажмите кнопку OK, чтобы закрыть диалоговое окно.

 10 Обновите дефекты непосредственно в таблице Defects Grid.

В таблице Defects Grid выберите Defect ID 23. Щелкните в поле Detected in 
Cycle и нажмите кнопку обзора. В дереве релизов разверните папку релиза 
Service Packs и релиза Service Pack 1. Установите флажок Cycle 1 - New 
Features и нажмите кнопку OK.

Щелкните в поле Target Cycle и нажмите кнопку обзора. В дереве релизов 
разверните папку релиза Service Packs и релиза Service Pack 1. 
Установите флажок Cycle 1 - New Features и нажмите кнопку OK.
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 11 Обновите дефекты 35 и 36.

Повторите шаг 10 для дефектов 35 и 36.

 12 Просмотрите ряд дефектов, открытых в цикле Cycle 1 - New Features 
на вкладке Quality.

Нажмите кнопку Releases на боковой панели.

В дереве релизов разверните папку релиза Service Packs и релиз Service 
Pack 1, а также выделите цикл Cycle 1 - New Features. Щелкните вкладку 
Quality.

На диаграмме Defect Opening Rate  видно 4 обнаруженных дефекта в 
цикле Cycle 1 - New Features. Двум дефектам присвоен уровень 
серьезности 4-Very High. Одному дефекту присвоен уровень серьезности 
3-High, и еще одному - 5-Urgent.
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На диаграмме Outstanding Defects  видно еще 3 необработанных дефекта 
в цикле Cycle 1 - New Features. 

Для просмотра значений состояния, выбранных для этого диаграммы, 
нажмите ссылку Configure Outstanding Defects. Откроется диалоговое 
окно Configure Outstanding Defects. 

По умолчанию отмечаются дефекты со статусом  New, Open и Reopen. 
Нажмите кнопку OK, чтобы закрыть диалоговое окно Configure Outstanding 
Defects.

Связывание дефектов с тестами
В плане тестирования вы можете связать тест с конкретным дефектом из 
таблицы Defects Grid. Это полезно, например, при создании нового теста 
специально для отслеживания того или иного дефекта. Создав такую 
связь, можно задать выполнение теста в зависимости от статуса дефекта. 
Обратите внимание, что также можно связать дефекты с другими 
объектами, такими как требования.

Дефекты могут быть связаны с объектами напрямую или косвенно. При 
добавлении связи дефекта к объекту Quality Center добавляет прямую 
связь к такому объекту и косвенные связи к другим связанным объектам. 
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На приведенной ниже схеме показан процесс косвенного связывания:

Например, при связывании дефекта с шагом выполнения добавляет 
косвенную связь к выполнению, экземпляру теста, набору тестов и тесту. В 
том случае, если этот тест покрывается требованием, косвенная связь 
добавляется также к требованию. Учтите, что косвенное связывание 
представляет собой однонаправленный процесс. Например, при 
связывании дефекта с выполнением дефект не является косвенно 
связанным с шагами выполнения.

В этом упражнении вы сможете связать дефект с тестом Cruise Booking 
модуля Test Plan и просмотреть связанные тесты в таблице Defects Grid.

Порядок связывания дефекта с тестом.

 1 Отобразите модуль Test Plan.

Нажмите кнопку Test Plan на боковой панели. 

 2 Выберите тест Cruise Booking.

В дереве плана тестирования разверните папки объектов Cruises и Cruise 
Reservation, и выделите тест Cruise Booking. Нажмите на вкладку Linked 
Defects.
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 3 Добавьте связанный дефект.

На вкладке Linked Defects нажмите стрелку Link Existing Defect и 
выберите Select. Откроется диалоговое окно Defects to Link. 

Выберите дефект, добавленный в «Добавление новых дефектов» на 
стр. 111 и нажмите кнопку Link. Дефект добавится в таблицу Linked 
Defects.

Примечание. Если невозможно обнаружить дефект в диалоговом окне 
Defects to Link, нажмите стрелку Set Filter/Sort и выберите команду Clear 
Filter/Sort, чтобы очистить фильтр, примененный к таблице.
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 4 Просмотрите связанный тест в таблице Defects Grid.

Нажмите кнопку Defects на боковой панели.

Выберите дефект в таблице Defects Grid и нажмите кнопку Defect Details. 
Откроется диалоговое окно Defect Details.

Нажмите Linked Entities на боковой панели и перейдите на вкладку 
Others. Вы увидите, что тест Cruise Booking связан с дефектом.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Defect Details.

Создание представления Favorite
Избранные представления - это отображение окна Quality Center с 
примененными к нему настройками. Например, в таблице Defects Grid 
можно применить фильтр для отображения только тех дефектов, которые 
были обнаружены именно вами, назначены вам или имеют статус “Not 
Closed”. 

В этом упражнении вы сможете создать избранное представление в 
таблице Defects Grid.

Порядок создания избранного представления.

 1 Убедитесь, что отображается модуль Defects.

Если модуль Defects не отображается, нажмите кнопку Defects на боковой 
панели. 
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 2 Определите фильтр для просмотра обнаруженных вами дефектов, 
которые еще не закрыты.

Нажмите кнопку Set Filter/Sort. Откроется диалоговое окно Filter. 

Нажмите поле Filter Condition, которое соответствует полю Detected By. 
Нажмите кнопку обзора. Откроется диалоговое окно Select Filter Condition.
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В столбце Name выберите свое регистрационное имя пользователя в 
Quality Center (alice_qc, cecil_qc или michael_qc). Нажмите кнопку OK, 
чтобы закрыть диалоговое окно Select Filter Condition.

Для поля Status  нажмите поле Filter Condition. Нажмите кнопку обзора. 
Откроется диалоговое окно Select Filter Condition.

На правой панели щелкните логическое выражение Not.

На левой панели выберите Closed.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы применить выбранный фильтр.

В таблице Defects Grid отобразятся обнаруженные вами дефекты, которые 
еще не закрыты.

 3 Добавьте избранное представление.

В меню Favorites выберите Add to Favorites. Откроется диалоговое окно 
Add Favorite.

В поле Name введите:  My detected defects (status ‘Not Closed’).
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Избранное представление можно добавить в общую или личную папку. 
Представления в общей папке доступны всем пользователям. Доступ к 
представлениям в личной папке имеют только их создатели. В целях этого 
упражнения выберите Private. 

Нажмите кнопку OK. Новое представление добавлено в вашу личную 
папку.

Теперь, когда вы познакомились с процессами добавления новых 
дефектов, поиска аналогичных дефектов, добавления дефектов, 
связывания дефектов с тестами и создания избранных представлений, 
можно переходить к занятию Урок 7, «Оповещение об изменениях». В 
уроке 7 вы узнаете, как отслеживать изменения, внесенные в требования, 
тесты и дефекты. 
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7
Оповещение об изменениях

Можно указать Quality Center автоматически создавать оповещения и 
отправлять сообщения по электронной почте с уведомлением 
ответственных лиц, когда в проекте происходят определенные изменения, 
способные оказать негативное влияние на процесс тестирования. Можно 
также добавлять собственные последующие оповещения.

Чтобы создавать автоматические уведомления с оповещениями , 
администратор проекта Quality Center должен активировать правила для 
оповещений в модуле Project Customization. Правила для оповещений 
основываются на связях, которые создаются в Quality Center между 
требованиями, тестами и дефектами. При изменении объекта в проекте 
Quality Center приводит в состояние готовности все связанные с ним 
объекты, на которые может оказать воздействие это изменение. Данные 
оповещения доступны для просмотра всеми пользователями. 
Quality Center также уведомляет лиц, ответственных за те или иные 
объекты, при внесении изменений в любые связанные объекты, на которые 
могут повлиять такие изменения.

Quality Center также позволяет добавлять собственные флажки 
отслеживания к конкретному требованию, тесту, экземпляру теста или 
дефекту для напоминания о необходимости отслеживания конкретного 
события. При наступлении даты оповещенияQuality Center отправит 
электронное сообщение с напоминанием об этом.

Этот урок содержит следующие разделы. Стр.

Инициирование оповещения 128

Создание оповещений об отслеживании 131
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Инициирование оповещения 
При изменении в проекте теста, экземпляра теста или дефекта, 
Quality Center может отправлять уведомления лицам, ответственным за 
связанные объекты. Тесты с требованиями (см. раздел «Сведения о 
создании и просмотре требований» на стр. 62) и дефектами можно 
связывать с другими объектами Quality Center (см. раздел «Связывание 
дефектов с тестами» на стр. 119). Кроме того, можно создавать связи 
прослеживаемости для требований  Дополнительные сведения о создании 
ссылок отслеживания между требованиями см. в документе Руководство 
пользователя HP Quality Center.

Quality Center может создавать оповещения при следующих изменениях.

➤ При изменении требования (за исключением смены состояния) 
Quality Center добавляет флаг оповещения ко всем связанным тестам и 
уведомляет их создателей по электронной почте.

➤ При изменении состояния дефекта на “Fixed” Quality Center добавляет 
флаг отслеживания ко всем связанным экземплярам тестов и уведомляет 
ответственных тестировщиков по электронной почте.

➤ При успешном выполнении теста Quality Center добавляет флаг 
отслеживания ко всем связанным дефектам и уведомляет назначенных 
пользователей по электронной почте.

➤ При изменении требования Quality Center добавляет флаг отслеживания ко 
всем прослеживаемым требованиям и дочерним требованиям и 
уведомляет их создателей по электронной почте.

В этом упражнении вы активируете функцию оповещения для тестов, 
сменив связанное требование. Вы измените требование Cruise Booking, а 
затем просмотрите тесты с флажками.

Для инициирования оповещений:

 1 Отобразите дерево требований.

Нажмите кнопку Requirements на боковой панели и выберите View > 
Requirement Details.
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 2 Выберите требование, которое нужно изменить.

Под требованием Cruise Reservation выделите требование Cruise 
Booking. 

 3 Просмотрите связанные тесты.

Для просмотра тестов, на которые окажет воздействие изменение, 
нажмите вкладку Test Coverage. На вкладке будут отображены связанные 
тесты.

 4 Измените приоритет требования Cruise Booking. 

Щелкните мышью вкладку Details.

Нажмите поле Priority для отображения стрелки вниз. Щелкните кнопку со 
стрелкой вниз и выберите 5-Urgent. 

Это изменение укажет Quality Center создать оповещения для тестов, 
связанных с этим требованием. Кроме того, Quality Center по электронной 
почте поставит в известность проектировщиков этих тестов. 

 5 Просмотрите оповещение для теста Cruise Booking.

На вкладке Test Coverage  нажмите тест Cruise Booking. Тест будет 
выделен в дереве плана тестирования.
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Нажмите кнопку Refresh All.

У теста Cruise Booking поставлен предупреждающий флажок , 
показывающий, что изменение внесено в связанное требование. 

Щелкните флажок Alerts для теста Cruise Booking. Откроется диалоговое 
окно Alerts. 

Предупреждение указывает на требование и изменение, которое 
спровоцировало оповещение. Оно также показывает на сотрудника, 
уведомленного по электронной почте о данном изменении. 

Нажмите кнопку Close.

 6 Просмотрите оповещения других связанных тестов.

Просмотрите оповещения следующих тестов в дереве плана тестирования. 
Cruise Search, Cancel All Reservations  и Airline Preference.
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Создание оповещений об отслеживании
Quality Center позволяет добавлять собственные оповещения, чтобы 
напомнить о необходимости отслеживания конкретных событий. В этом 
упражнении вы добавите флажок отслеживания к дефекту, статус 
которого следует проверить через неделю после сегодняшней даты.

При добавлении флажка отслеживания  Quality Center также добавляет 
информационную панель, напоминающую о необходимости оповещения. 
При наступлении даты оповещения Quality Center отправит электронное 
сообщение с напоминанием об этом и изменит цвет пиктограммы флажка с 
серого на красный.

Обратите внимание, что флажки отслеживания связаны с конкретным 
пользователем, что означает, что только их автор может просматривать 
оповещения об отслеживании.

Для создания оповещения об отслеживании:

 1 Отобразите модуль Defects.

Нажмите кнопку Defects на боковой панели.

 2 Выберите дефект, рядом с которым нужно поставить флажок с 
напоминанием об отслеживании.

В таблице Defects Grid выберите дефект.

 3 Создайте оповещение об отслеживании.

Нажмите кнопку  Flag for Follow Up. Откроется диалоговое окно Flag for 
Follow Up. 
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Выполните следующие действия:

Follow up by: Выберите дату через неделю от сегодняшней даты.

Description: Введите: Remind me about this defect on this date.

Нажмите кнопку OK. Флажок  будет добавлен к сведениям о дефекте.
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 4 Отобразите информационную панель для оповещения об 
отслеживании.

Дважды щелкните дефект с флажком отслеживания. Откроется диалоговое 
окно Defect Details и отобразится информационная панель с оповещением 
об отслеживании.

Чтобы закрыть диалоговое окно, нажмите кнопку Cancel.

Теперь, когда вы познакомились с оповещениями об изменениях, можно 
переходить к занятию Урок 8, «Анализ процесса тестирования». В уроке 8 
вы узнаете, как создавать отчеты и диаграммы, помогающие 
анализировать процесс тестирования. 
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Анализ процесса тестирования

Отчеты и диаграммы, создаваемые в Quality Center, помогают оценить 
процесс тестирования. Отчеты и диаграммы можно создавать в любое 
время в процессе тестирования в модулях Requirements, Test Plan, Test Lab 
и Defects с использованием настроек по умолчанию или пользовательских. 
При настройке отчета или диаграммы можно применять фильтры и условия 
сортировки, а также отображать информацию в соответствии с 
конкретными требованиями. Кроме того, можно сохранять настройке в виде 
избранного представления и загружать их при необходимости.

Примечание. Также можно использовать диаграммы анализа в реальном 
времени, генератор документов и генератор отчетов Excel для 
дальнейшего анализа данных Quality Center в Microsoft Word или Microsoft 
Excel. Подробные сведения об этих средствах анализа приведены в 
документе Руководство пользователя HP Quality Center.

Этот урок содержит следующие разделы: Стр.

Создание отчетов 136

Создание диаграмм 142
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Создание отчетов
Отчеты можно создавать в модулях Requirements, Test Plan, Test Lab и 
Defects. Каждый из этих модулей содержит различные параметры отчетов. 
После создания отчета в свойствах отчета можно настроить отображение 
информации в соответствии с конкретными требованиями.

В этом упражнении вы создадите отчет о стандартных требованиях, 
настроите отчет для конкретного имени пользователя и добавите его в 
список избранных представлений.

Для создания отчета:

 1 Откройте проект QualityCenter_Demo.

Если проект QualityCenter_Demo еще не открыт, зарегистрируйтесь в 
проекте. Дополнительные сведения см. в разделе «Запуск Quality Center» 
на стр. 15.

 2 Отобразите модуль Requirements.

Нажмите кнопку Requirements на боковой панели и отобразите дерево 
требований.

 3 Выберите отчет.

Выберите Analysis > Reports > Standard Requirements Report. Откроется 
отчет с данными по умолчанию. 
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 4 Отобразите параметры настройки.

Нажмите кнопку Configure Report and Sub-Reports. Откроется страница 
Report Customization с параметрами по умолчанию.

 5 Задайте количество элементов, которые должны отображаться на 
странице.

Под Page выберите All items in one page, чтобы отобразить все элементы 
на одной странице.
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 6 Задайте фильтр для просмотра требований, созданных конкретным 
пользователем.

Под Filter нажмите кнопку Set Filter/Sort. Откроется диалоговое окно Filter. 

Для поля Author щелкните поле Filter Condition. Нажмите кнопку обзора. 
Откроется диалоговое окно Select Filter Condition.
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В столбце Name выберите свое имя пользователя для входа в 
Quality Center (alice_qc, cecil_qc или michael_qc). Нажмите кнопку OK, 
чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter.

 7 Задайте поля и порядок их отображения. 

Под пунктом Fields выберите Custom Fields (layout) и нажмите кнопку 
Select Fields. Откроется диалоговое окно Select Fields. 

В поле Available Fields  перечислены поля, которые не отображаются на 
данный момент. В поле Visible Fields  перечислены поля, которые 
отображаются в данный момент.

В поле Visible Fields  выберите Creation Time и щелкните стрелку влево, 
чтобы переместить поле в область Available Fields. Переместите Modified  
в область Available Fields.
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Чтобы задать порядок отображения полей, выберите ReqID и щелкните 
стрелку вверх, чтобы переместить поле под пункт Author. Переместите 
Name и Description, чтобы они отобразились под ReqID.

Совет. Можно также использовать перетаскивание для задания полей и 
порядка их отображения.

Нажмите кнопку OK, чтобы закрыть диалоговое окно и отобразить поля в 
новом порядке.

 8 Очистите параметры Attachments и History.

Под Fields снимите флажки полей Attachments и History.
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 9 Создайте новый отчет.

Нажмите кнопку Apply. Отобразится пользовательский отчет Requirements 
Report. 

 10 Добавьте отчет как избранное представление.

Нажмите кнопку Add to Favorites. Откроется диалоговое окно Add Favorite.

В поле Name введите:  Standard Requirements by Author. Нажмите кнопку 
OK. Отчет добавляется в список Reports в левой области.

 11 Закройте отчет.

Нажмите кнопку Close. Отобразится модуль Requirements.

Совет. Можно создать быстрый отчет для конкретных узлов дерева или 
строк таблицы путем выбора требований, тестов или дефектов и перехода 
Analysis > Report Selected. Можно выбрать несколько узлов или строк, 
нажав клавишу CTRL.
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Создание диаграмм
Диаграммы Quality Center помогают анализировать взаимосвязи между 
различными типами данных в проекте. Каждый модуль Quality Center 
содержит различные параметры диаграмм. После создания диаграммы в 
свойствах диаграммы можно настроить отображение информации в 
соответствии с конкретными требованиями. 

В этом упражнении вы научитесь создавать диаграммы дефектов для 
сводки по состоянию и приоритету.

Для создания диаграммы:

 1 Отобразите модуль Defects.

Нажмите кнопку Defects на боковой панели. В модуле Defects отобразится 
таблица Defects Grid.

Нажмите на стрелку Set Filter/Sort и выберите Clear Filter/Sort, чтобы 
снять фильтр, примененный к таблице Defects Grid.

 2 Выберите диаграмму.

Выберите Analysis > Graphs > Summary - Group by ‘Status’. Откроется 
диаграмма Defects - Summary Graph. По умолчанию диаграмма 
группируется по состоянию Status.
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 3 Откройте диалоговое окно Filter.

Нажмите кнопку Filter. Откроется диалоговое окно Filter. 

 4 Задайте фильтр для просмотра дефектов, имеющих уровни 
приоритетов от «высокий» до «безотлагательный».

В диалоговом окне Filter для поля Priority щелкните поле Filter Condition. 
Нажмите кнопку обзора. Откроется диалоговое окно Select Filter Condition.
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На правой панели щелкните логическое выражение >=.

На левой панели выберите 3-High.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

 5 Задайте фильтр для просмотра еще не закрытых дефектов.

Для поля Status  нажмите поле Filter Condition. Нажмите кнопку обзора. 
Откроется диалоговое окно Select Filter Condition.

На правой панели щелкните логическое выражение Not.

На левой панели выберите Closed. 

Нажмите кнопку OK, чтобы закрыть диалоговое окно Select Filter Condition.

Нажмите кнопку OK, чтобы закрыть диалоговое окно Filter.

 6 Задайте ось Х диаграммы.

Из списка X-Axis с правой стороны окна выберите Priority для просмотра 
дефектов по приоритету.

 7 Обновите диаграмму.

Нажмите кнопку Refresh. Отобразится новая диаграмма. 
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В этом упражнении девяти дефектам присвоен уровень приоритета 3-High, 
восьми дефектам присвоен уровень 4-Very High и еще одному - 5-Urgent.

 8 Отобразите дополнительные сведения о дефекте.

Нажмите на строчный сегмент диаграммы. Откроется диалоговое окно Drill 
Down Results, в котором отображены дефекты, относящиеся к данному 
строчному сегменту. 

Закройте диалоговое окно Drill Down Results.

 9 Отобразите другие представления диаграммы.

Нажмите вкладку Pie Chart для отображения диаграммы в виде секторной 
диаграммы.

Нажмите вкладку Data Grid для отображения данных в виде таблицы.

 10 Закройте диаграмму.

Нажмите кнопку Close. Отобразится модуль Defects.
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Теперь, когда вы познакомились с процессом создания отчетов и 
диаграмм, можно переходить к занятию Урок 9, «Настройка проектов». В 
уроке 9 вы узнаете, как настраивать проект, добавляя и определяя 
пользователя проекта. Вы также научитесь добавлять поле, определяемое 
пользователем, и создавать список проекта. 
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Настройка проектов

В предыдущих уроках вы узнали, как использовать Quality Center для 
управления всеми этапами тестирования приложений, включая 
определение релизов и циклов, формулирование требований к 
тестированию, планирование тестирования, выполнение тестов и 
отслеживание дефектов.

На этом уроке вы научитесь настраивать свой проект Quality Center в 
соответствии с требованиями группы тестирования.  Доступ к проекту 
можно контролировать, определяя пользователей, имеющих права доступа 
к нему, и задавая типы задач, которые каждый пользователь может 
выполнять. Предположим, в вашу группу тестирования добавляются новые 
члены. Вы назначаете их проектам, тестирование которых они будут 
осуществлять, и задаете задачи, которые они могут выполнять. 

Вы также можете настраивать свой проект Quality Center, изменяя его 
системные поля или добавляя поля, определяемые пользователем. Поля 
могут быть связаны с системными списками и списками, определяемыми 
пользователями.  Список содержит значения, которые пользователь может 
ввести в поле. Например, если тестируются несколько сборок приложения, 
в модуль Defects можно добавить поле Detected in Build. Затем можно 
создать список, содержащий значения Build1, Build2 и Build3, и связать 
список с полем Detected in Build.

Этот урок содержит следующие разделы: Стр.

Начало настройки проекта 148

Добавление в проект нового пользователя 151

Распределение пользователей по группам 154
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Начало настройки проекта
Проекты Quality Center настраиваются с использованием окна Project 
Customization. В этом упражнении вы откроете окно Project Customization с 
правами администратора проекта.

Как начать настройку проекта

 1 Откройте окно входа в HP Quality Center.

Убедитесь, что открылось окно входа в HP Quality Center. Дополнительные 
сведения см. в разделе «Запуск Quality Center» на стр. 15.

 2 Введите имя пользователя с правами администратора и подтвердите 
подлинность.

В поле Login Name введите alex_qc.

Пропустите поле Password. Этому пользователю не присвоен пароль.

Нажмите на кнопку Authenticate. Quality Center проверит ваше имя 
пользователя и пароль и определит, к каким доменам и проектам вы 
имеете право доступа. 

 3 Войдите в проект.

В списке Domain выберите Default.

В списке Project выберите QualityCenter_Demo. 

Нажмите кнопку Login.

Откроется главное окно Quality Center и отобразится модуль, в котором вы 
работали в прошлый раз.

Настройка поля, определенного пользователем 157

Создание списка проекта 160

Этот урок содержит следующие разделы: Стр.
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 4 Откройте окно Project Customization.

Выберите Tools > Customize в правом верхнем углу окна Quality Center. 
Откроется окно Project Customization.

По умолчанию в окне Project Customization содержатся следующие ссылки:

Параметр Описание

User Properties Позволяет изменять свойства пользователя. 
Например, можно изменить свой адрес электронной 
почты. Также можно изменить свой пароль.

Project Users Позволяет добавлять в проект Quality Center 
пользователей и удалять их из него. Можно также 
вводить пользователей в группы пользователей и 
ограничивать их права доступа.

Groups Позволяют назначать привилегии группам 
пользователей, задавая для них конкретные 
параметры прав доступа.

Module Access Позволяет контролировать модули, к которым имеют 
доступ группы пользователей. Повышения 
эффективности лицензий Quality Center можно 
добиться, если запретить пользователям доступ к 
модулям, к которым они не имеют прав доступа.
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Project Entities Позволяют изменять поведение системных полей 
Quality Center или задавать уникальные для проекта 
поля, определяемые пользователем. Например, если 
осуществляется выполнение тестов нескольких 
версий сборки приложения, в диалоговое окно New 
Defect можно добавить определенное пользователем 
поле Detected in Build. Затем можно связать его со 
списком, в котором содержатся значения для этого 
поля.

Requirement Types Позволяют настраивать определения типов 
требований.

Risk-Based Quality 
Management

Позволяет задавать параметры управления 
качеством на основе рисков.

Project Lists Позволяют добавлять в проект пользовательские 
списки. В список входят значения, которые 
пользователь может вводить в систему или в поля, 
определяемые пользователем. Например, для поля 
Detected in Build можно создать список, содержащий 
значения Build1, Build2 и Build3.

Automail Позволяет настроить автоматическую рассылку 
сообщений электронной почты, уведомляющих 
пользователей о каждом изменении, внесенном в 
конкретные дефекты.

Alert Rules Позволяют активировать правила оповещений для 
проекта. Указывает Quality Center создавать 
оповещения и отправлять уведомления по 
электронной почте об изменениях в проекте.

Workflow Позволяет создавать скрипты для часто 
используемых настроек полей в диалоговых окнах 
модуля Defects. Кроме того, вы можете написать 
скрипты для настройки диалоговых окон любого 
модуля и контролировать действия, выполняемые 
пользователем.

Параметр Описание
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В следующих уроках вы будете использовать следующие параметры: 
Project Users, Project Entities и Project Lists. Подробные сведения о 
вышеуказанных параметрах приведены в документе Руководство 
администратора HP Quality Center.

Добавление в проект нового пользователя
Доступ к проекту Quality Center можно контролировать с помощью 
определения пользователей, имеющих права доступа к проекту, и задания 
типов задач, которые каждый пользователь может выполнять.

Для каждого проекта выбираются пользователи из списка пользователей 
сайта Quality Center. Этот список создается в области Site Administration.

В окне Project Customization в проект добавляются пользователи и 
вносятся в группы пользователей. Каждая группа пользователей имеет 
право доступа к определенным задачам Quality Center. 

В этом упражнении вы добавите нового пользователя в проект 
QualityCenter_Demo.

Для добавления нового пользователя в проект:

 1 Убедитесь, что вы вошли в Quality Center с правами администратора.

Дополнительные сведения о том, как открыть окно Project Customization см. 
в разделе «Начало настройки проекта» на стр. 148.
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 2 Откройте страницу Project Users.

В окне Project Customization щелкните ссылку Project Users. Откроется 
страница Project Users, на которой отобразится список пользователей, 
назначенных проекту.

 3 Добавьте нового пользователя.

Нажмите кнопку Add User. Откроется диалоговое окно Add User to Project.
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В это диалоговое окно можно добавлять существующего пользователя из 
списка пользователей сайта, вводя имя пользователя или выбирая его из 
списка пользователей сайта. Также можно создать нового пользователя и 
добавить его в проект. В этом упражнении вы добавите существующего 
пользователя, печатая его имя.

Убедитесь, что установлен переключатель Add user by user name. В поле 
Add user by user name введите tom_qc и нажмите OK.

Новый пользователь будет добавлен в список Project Users, а свойства 
пользователя будут отображены в области Personal Settings. Личные 
настройки пользователя устанавливаются в Site Administration.
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Распределение пользователей по группам
Чтобы пользователи могли выполнять свои задачи, а также в целях защиты 
от несанкционированного доступа Quality Center позволяет распределять 
всех пользователей по конкретным группам. Каждая группа имеет право 
доступа к определенным задачам Quality Center. Можно использовать 
предварительно заданные группы пользователей с правами по умолчанию 
или настроить собственные группы с уникальными наборами прав. 

В следующей таблице приведены предварительно заданные группы 
пользователей Quality Center и их права по умолчанию:

Группа 
пользователей Права

TDAdmin 
(Project 
Administrator)

Члены группы обладают всеми правами в проекте 
Quality Center и в окне Project Customization.

Project Manager Члены группы обладают всеми правами в следующих 
модулях Quality Center: Releases, Requirements, Test Plan, 
Test Lab и Defects. В окне Project Customization группа 
имеет право изменять свойства и пароли пользователей, 
настраивать списки проекта и устанавливать правила 
оповещений.

QATester Члены группы обладают всеми правами в следующих 
модулях Quality Center: Releases, Requirements, Test Plan и 
Test Lab. В модуле Defects группа может добавлять и 
исправлять дефекты и связи дефектов. В окне Project 
Customization группа имеет право изменять свойства и 
пароли пользователей, настраивать списки проекта и 
устанавливать правила оповещений.
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В этом упражнении вы добавите нового пользователя в группу 
пользователей QATester.

Developer Члены группы обладают правами только на исправление 
вложений или запись данных в следующих модулях 
Quality Center: Requirements, Test Plan и Test Lab. В модуле 
Releases члены группы обладают всеми правами. В модуле 
Defects группа может добавлять и исправлять дефекты, а 
также добавлять связи дефектов. В окне Project 
Customization члены группы имеют право изменять 
свойства пользователей и пароли.

Viewer Члены группы обладают только правами на чтение в 
проекте Quality Center и не имеют прав в окне Project 
Customization.

Группа 
пользователей Права
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Для добавления пользователя в группу:

 1 Убедитесь, что отображается страница Project Users.

Если окно Project Users еще не открыто, нажмите ссылку Project Users в 
окне Project Customization.

 2 Выберите tom_qc из списка Project Users.

В списке Project Users выберите tom_qc.  Отобразятся свойства 
пользователя. По умолчанию новый пользователь добавляется в группу 
Viewer.

 3 Введите tom_qc в группу QATester.

Под пунктом Not Member Of выберите пункт QATester и щелкните стрелку 
влево, чтобы переместить его в область Member Of.
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 4 Удалите tom_qc из группы Viewer.

Под Member Of выберите пункт Viewer и щелкните  стрелку вправо, чтобы 
переместить его в область Not Member Of.

Нажмите кнопку Save, чтобы сохранить изменения на странице Project 
Users. Нажмите кнопку OK.

Настройка поля, определенного пользователем
Можно настроить проект Quality Center таким образом, чтобы он полностью 
соответствовал вашим требованиям к тестированию. Вы можете изменять 
поведение системных полей Quality Center или выбирать уникальные для 
проекта поля, определяемые пользователем.

Поля сохраняются в объектах проекта Quality Center. Например, объект 
Defect содержит данные, введенные в модуле Defect.

В следующем упражнении вы добавите определяемое пользователем поле 
Database в объект Defect. Это поле указывает на базу данных, 
используемую при тестировании приложений.

Для добавления поля, определяемого пользователем:

 1 Убедитесь, что отображается окно Project Customization.

Дополнительные сведения о том, как открыть окно Project Customization см. 
в разделе «Начало настройки проекта» на стр. 148.
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 2 Откройте страницу Project Entities.

В окне Project Customization нажмите ссылку Project Entities. Откроется 
страница Project Entities.

Доступны следующие объекты проекта:

Объект Описание

Cycle Данные цикла в модуле Releases.

Defect Данные дефекта в модуле Defects.

Release Данные релиза в модуле Releases.

Release Folder Данные папки релизов в модуле Releases.

Requirement Данные требования в модуле Requirements.

Run Данные выполнения теста в модуле Test Lab.

Test Данные теста в модуле Test Plan.

Test Instance Данные экземпляра теста в модуле Test Lab.
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 3 Добавьте новое поле, определяемое пользователем, в объект Defect.

Под пунктом Project Entities разверните Defect. 

Нажмите на папку User Fields и нажмите кнопку New Field. Новое поле 
добавится под папку User Fields.

Надпись BG_USER_XX указывает на поле, определяемое пользователем, 
под объектом Defect.

 4 Переименуйте имя поля по умолчанию.

В поле Field Label вместо имени по умолчанию введите имя Database. 
Новое имя поля отобразится в Quality Center.

Нажмите кнопку Save.

Test Set Данные набора тестов в модуле Test Lab.

Test Step Данные шагов разработки теста в модуле Test Plan, а 
также данные шагов теста в модуле Test Lab.

Объект Описание
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Нажмите кнопку OK.

Создание списка проекта
Поля можно связывать с системными списками и списками, 
определяемыми пользователями. Список содержит значения, которые 
пользователь может ввести в поле. 

В предыдущем упражнении вы добавили поле Database. В ходе 
следующего упражнения вы создадите список и присвоите его полю 
Database. Затем вы откроете диалоговое окно New Defect для просмотра 
нового поля.

Порядок создания списка проекта.

 1 Убедитесь, что отображается окно Project Customization.

Дополнительные сведения о том, как открыть окно Project Customization см. 
в разделе «Начало настройки проекта» на стр. 148.

 2 Откройте страницу Project Lists.

В окне Project Customization щелкните ссылку Project Lists. Откроется 
страница Project Lists.
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 3 Создайте новый список.

Нажмите New List. Откроется диалоговое окно New List.

В поле List Name введите DB. Нажмите кнопку OK, чтобы закрыть 
диалоговое окно New List.

 4 Добавьте элемент в список.

Нажмите New Item. Откроется диалоговое окно New Item. Введите Oracle и 
нажмите кнопку OK.

Повторите ту же самую процедуру и добавьте MS SQL и MSDE в список 
DB.

Нажмите кнопку Save, чтобы сохранить изменения на странице Project 
Lists. Нажмите кнопку OK.
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 5 Присвойте список полю Database.

В окне Project Customization щелкните ссылку Project Entities. Откроется 
страница Project Entities.

Под Project Entities разверните Defect.

Раскройте папку User Fields и выберите Database.

Под Field Settings в списке Field Type выберите Lookup List для установки 
типа поля в виде раскрывающегося списка. Раздел Lookup List 
отображается под разделом Field Settings.

Под Lookup List выберите DB. 

Нажмите кнопку Save, чтобы сохранить изменения на странице Project 
Entities. Нажмите кнопку OK.
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 6 Просмотрите новое поле, определяемое пользователем, в 
диалоговом окне New Defect.

Для выхода из окна Project Customization и возврата в проект Quality Center 
нажмите кнопку Return в правом верхнем углу окна.

В модуле Defects нажмите кнопку New Defect. Откроется диалоговое окно 
New Defect. 

Поле Database отображается в диалоговом окне New Defect. Нажмите 
кнопку со стрелкой вниз и просмотрите заданные вами типы баз данных. 
Нажмите кнопку Close.

Новое поле, 
определяемое 
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Теперь, когда вы познакомились с процессом настройки проектов, можно 
переходить к занятию Урок 10, «Дальнейшие действия» В уроке 10 вы 
узнаете, как применять понятия Quality Center и приобретенные навыки к 
вашему приложению.
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Дальнейшие действия

Теперь, после завершения работы с данным учебным пособием, вы готовы 
применять концепции Quality Center и полученные навыки к вашему 
приложению. Вам также потребуется информация о дополнительных 
материалах.

Приступая к работе
Управление тестированием с помощью Quality Center состоит из пяти 
этапов: определение релизов, определение требований, разработка плана 
тестирования, выполнение тестов и отслеживание дефектов. На каждом 
этапе можно анализировать данные, создавая подробные отчеты и 
диаграммы.

Для начала работы:

 1 Разработайте план создания релизов и определите циклы для них.

При разработке плана создания релизов выполните следующие шаги:

➤ Определите, как разбить релизы приложения на компоненты.

➤ Для каждого релиза определите способ его разбиения на циклы.

➤ Проведите анализ процесса создания релизов и циклов и их качества.

Этот урок содержит следующие разделы: Стр.

Приступая к работе 165

Библиотека документации 168

Дополнительные сетевые ресурсы 170
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 2 Проанализируйте приложение и определите требования.

При определении требований выполните следующие шаги:

➤ Изучите документацию по приложению, чтобы определить цели, задачи 
и стратегии тестирования.

➤ Создайте дерево требований для определения общих требований. 
После разработки тестов можно использовать их для покрытия 
требований. Таким образом можно отслеживать требования к 
тестированию на всех этапах процесса тестирования.

➤ Для каждого раздела требования из дерева требований создайте 
перечень подробных требований. Опишите каждое требование, задайте 
уровень приоритета для каждого требования, назначьте его релизу и 
циклу и при необходимости добавьте вложение.

➤ Создайте отчеты и диаграммы, позволяющие облегчить анализ 
требований. Проведите обзор требований, чтобы обеспечить их 
соответствие целям и задачам тестирования.

 3 На основе требований разработайте план тестирования.

При создании плана тестирования выполните следующие шаги.

➤ Изучите приложение, системную среду и ресурсы тестирования, чтобы 
определить цели тестирования.

➤ Разбейте приложение на тестируемые модули или функциональные 
блоки. Создайте дерево плана тестирования, чтобы иерархически 
разбить приложение на тестируемые модули или объекты.

➤ Определите типы тестов для каждого модуля. Добавьте базовое 
определение каждого теста в дерево плана тестирования.

➤ Свяжите каждый тест с соответствующим требованием.

➤ Разработайте ручные тесты, добавив шаги к тестам дерева плана 
тестирования. Шаги теста содержат описание конкретных действий по 
тестированию и ожидаемый результат каждого теста. Решите, какие 
тесты следует автоматизировать. Впоследствии можно связать тесты с 
дефектами.
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➤ Создайте сценарии тестов, которые нужно автоматизировать. 
Автоматизация тестов может осуществляться с использованием 
средств тестирования HP, пользовательских средств тестирования или 
средств тестирования сторонних производителей.

➤ Создайте отчеты и диаграммы, чтобы облегчить анализ данных плана 
тестирования. Проведите обзор тестов, чтобы определить их 
соответствие целям тестирования.

 4 Создайте наборы тестов и выполните тесты.

При создании наборов тестов и выполнении тестов выполните следующие 
шаги:

➤ Определите папки наборов тестов и наборы тестов, которые 
соответствуют различным целям тестирования в вашем проекте. 
Каждую папку наборов тестов назначьте циклу. Решите, какие наборы 
тестов включать в соответствующие папки с наборами тестов, и какие 
тесты включать в каждый набор.

➤ Составьте расписание запуска тестов и поставьте задачи перед 
тестировщиками приложения. 

➤ Вручную или автоматически выполните тесты из наборов тестов.

➤ Просмотрите результаты выполнения тестов для выявления дефектов в 
приложении. Создайте отчеты и диаграммы, облегчающие анализ этих 
результатов.

 5 Зарегистрируйте в проекте обнаруженные в приложении дефекты и 
отследите процесс их устранения.

Для регистрации дефектов в проекте и их отслеживания выполните 
следующие шаги:

➤ Зарегистрируйте новые дефекты, обнаруженные в приложении. 

➤ Добавьте связь дефекта со следующими объектами: требованиями, 
тестами, наборами тестов, экземплярами тестов, выполнениями тестов, 
шагами выполнения и другими дефектами.

➤ Проанализируйте новые дефекты и определите дефекты, подлежащие 
устранению.

➤ Устраните дефекты.
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➤ Выполните тестирование новой сборки приложения. Повторяйте этот 
процесс до устранения дефектов.

➤ Создайте отчеты и диаграммы, облегчающие анализ процесса 
устранения дефектов и помогающие определить срок выпуска 
приложения.

Библиотека документации
Библиотека документации представляет собой интерактивную справку, в 
которой описана процедура использования Quality Center. Получить доступ 
к ресурсу Библиотека документации можно следующими способами:

➤ Нажмите кнопку Библиотека документации в меню Help Quality Center, 
чтобы открыть главную страницу Библиотека документации. На главной 
странице находятся ссылки для быстрого перехода к основным 
разделам справки.

➤ Нажмите кнопку Help on this page в меню Help Quality Center, чтобы 
открыть раздел Библиотека документации, который относится к текущей 
странице.

Руководства комплекта документации 
Комплект документации состоит из следующих электронных или PDF (или 
тех и других) руководств и справочных материалов. Документы в формате 
PDF можно просматривать и распечатывать в программе Adobe Reader, 
которую можно загрузить с веб-узла компании Adobe 
(http://www.adobe.com).

В разделе Приступая к работе описана процедура использования 
комплекта документации и ее структура. (Доступно в электронном виде).

В разделе Что нового? содержится описание новых функций, 
добавленных в последнюю версию Quality Center. (Доступно в электронном 
виде и в формате PDF).
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Получить доступ к разделу What’s New? также можно из меню Help 
продукта Quality Center. Кроме того, чтобы просмотреть короткие ролики, 
демонстрирующие основные функции продукта, выберите Help > Product 
Feature Movies. 

Файл Readme содержит самые последние новости и сведения о 
Quality Center. 

Руководства Quality Center:
Руководство пользователя HP Quality Center содержит описание 
процедуры использования Quality Center для упорядочивания и 
выполнения всех этапов процесса тестирования. В нем описывается, как 
определять требования, планировать и выполнять тесты и отслеживать 
дефекты. (Доступно в электронном виде и в формате PDF).

Руководство HP Quality Center Administrator’s Guide содержит описание 
процедуры создания и ведения проектов с помощью функции Site 
Administration. В нем также описано, как настраивать проекты в окне Project 
Customization. (Доступно в электронном виде и в формате PDF).

Учебное руководство по HP Quality Center представляет собой 
материалы для самостоятельного изучения порядка использования 
Quality Center для организации процесса тестирования программного 
обеспечения. (Доступно в формате PDF).

Руководство по установке HP Quality Center разъясняет процедуру 
установки Quality Center на сервере в кластерной среде или в качестве 
автономного приложения. (Доступно в формате PDF).

Руководства по HP Business Process Testing:
Руководство пользователя HP Business Process Testing User’s Guide 
разъясняет, как использовать HP Business Process Testing для создания 
тестов бизнес-процессов. (Доступно в электронном виде и в формате PDF).

Учебное руководство по HP Business Process Testing представляет 
собой материалы для самостоятельного изучения основных сведений об 
использовании продукта HP Business Process Testing в Quality Center. 
(Доступно в формате PDF).
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Справочные материалы по прикладному программному 
интерфейсу (API):
HP Quality Center Database Reference – это полный комплект электронной 
документации по таблицам и полям базы данных проекта. (Доступен в 
электронном виде).

HP Quality Center Open Test Architecture API Reference – это полный 
комплект электронной документации по API Quality Center на основе COM. 
Открытую архитектуру тестирования Quality Center можно использовать 
для интеграции средств пользователя по настройке конфигурации, средств 
отслеживания дефектов и пользовательских средств тестированию в 
проекте Quality Center. (Доступен в электронном виде).

 HP Quality Center Site Administration API Reference – это полный 
комплект электронной документации по API администрирования узлов на 
основе COM. Интерфейс API администрирования узлов можно 
использовать для того, чтобы приложение выполняло функции 
упорядочивания, управления и ведения пользователей, проектов, доменов, 
подключений и настройки параметров сайта Quality Center. (Доступен в 
электронном виде).

Руководство HP Quality Center Custom Test Type Guide – это полное 
электронное руководство по созданию пользовательских средств 
тестирования и их интеграции в продукт Quality Center. (Доступен в 
электронном виде).

 

Дополнительные сетевые ресурсы
В меню Help продукта Quality Center доступны следующие дополнительные 
сетевые ресурсы:

Troubleshooting and Knowledge Base предоставляет доступ к странице 
Troubleshooting веб-сайта HP Software Support, на которой можно найти 
базу знаний по самостоятельному устранению неполадок. Выберите Help > 
Troubleshooting and Knowledge Base. URL-адрес этого веб узла: 
http://h20230.www2.hp.com/troubleshooting.jsp.
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HP Software Support предоставляет доступ к веб-узлу HP Software Support. 
Этот веб-узел позволяет осуществлять поиск в базе знаний по 
самостоятельному устранению неполадок. Кроме того, пользователи могут 
просматривать форумы и оставлять в них сообщения, подавать заявки на 
предоставление поддержки, загружать исправления и обновленную 
документацию и выполнять другие операции. Перейдите по пунктам меню 
Help > HP Software Support. Адрес этого веб-узла 
www.hp.com/go/hpsoftwaresupport.

Для получения доступа к большинству разделов поддержки сначала 
необходимо зарегистрироваться в качестве пользователя службы НР 
Passport, а затем войти в систему. Для ряда разделов поддержки также 
необходимо наличие контракта на оказание поддержки.

Получить более подробные сведения об уровнях доступа можно по адресу: 
http://h20230.www2.hp.com/new_access_levels.jsp

Чтобы зарегистрироваться на получение идентификатора пользователя 
службы НР Passport, перейдите на страницу: 
http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site предоставляет доступ к веб-узлу программного 
обеспечения компании НР. На этом веб-узле приведенные самые 
последние сведения относительно программных продуктов НР, а именно: 
сведения о новых релизах программного обеспечения, семинарах и 
выставках, поддержке клиентов и т.д. Выберите 
Help > HP Software Web site. Адрес этого веб-узла 
www.hp.com/go/software.

Add-ins Page открывает HP Quality Center Add-ins Page, которая позволяет 
интегрировать средства тестирования НР и сторонних производителей, 
инструменты для синхронизации и управления версиями. Дополнительные 
сведения см. в документе Руководство по установке HP Quality Center.
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